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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.

Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO
UNDER THE LINK “Avaya Terms of Use for Hosted Services” OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR

IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN
AVAYA AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The
applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
computing device. “Server” means a Designated Processor that
hosts a software application to be accessed by multiple users.
“Instance” means a single copy of the Software executing at a
particular time: (i) on one physical machine; or (ii) on one deployed
software virtual machine (“VM”) or similar deployment.

License types
Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.

Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/LicenseInfo
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Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note that
each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.

Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.

The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG
LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY
FROM THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL
PARTNER’S HOSTING OF AVAYA PRODUCTS MUST BE
AUTHORIZED IN WRITING BY AVAYA AND IF THOSE HOSTED
PRODUCTS USE OR EMBED CERTAIN THIRD PARTY
SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT
SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS
REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE
LICENSE AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S
EXPENSE, DIRECTLY FROM THE APPLICABLE THIRD PARTY
SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE

AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE 
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.

Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).

Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.

Regulatory Statements
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.

https://support.avaya.com/Copyright
https://support.avaya.com/Copyright
HTTP://WWW.MPEGLA.COM
http://www.sipro.com/contact.html
HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM
https://support.avaya.com
https://support.avaya.com/security
https://support.avaya.com/security
https://support.avaya.com/css/P8/documents/100161515
https://support.avaya.com/css/P8/documents/100161515
https://support.avaya.com
https://support.avaya.com
https://support.avaya.com


Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Purpose
This document describes how to use Avaya Workforce Optimization Select features.

This document is intended for people who want to learn how to use Avaya Workforce Optimization
Select features.
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Chapter 2: Navigation

Logging in to the Avaya Workforce Optimization Select
About this task
Users can access the Avaya Workforce Optimization Select application through a web browser and
sign in using their login credentials.

Before you begin
Get the following information from your system administrator:

• The URL of the Avaya Workforce Optimization Select web application
• The user name and password to access the application

Procedure
1. In the Address bar of the browser, enter the URL for your instance of Avaya Workforce

Optimization Select.

For example: https://<host>:<port> where

<host> is the host name or IP address of the server on which Avaya Workforce Optimization
Select is installed.

<port> is the data port for communication.

2. On the Avaya Workforce Optimization Select login page, enter the Username and
Password, and click Sign In.

The system displays the Avaya Workforce Optimization Select application Home page.

Logging out of the Avaya Workforce Optimization Select
application

Procedure
1. In the top-right corner of the Home page, click the  icon.

2. Click Log Out.

On successful log out, the system displays the Avaya Workforce Optimization SelectSign In
screen.
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Avaya Workforce Optimization SelectHome page
When you log in to Avaya Workforce Optimization Select, the Home page displays navigation links
for quick access to the modules in the application.

Note:

The administrator configures module level access privileges for each user. You can see only those
modules for which the system administrator provides you access.

The interface has the following sections:

• The title bar: To navigate to the My Profile settings.

• The main menu: To navigate to the different modules in the application.

• The side bar: To navigate to the submenu within each module.

• The navigation bar: To navigate to the submenu options within each module.

Menus
Main Menu

Name Description
Home Provides quick access to all modules in the application and back to the

Home page from any page.
Notifications Displays alerts and notifications that you have subscribed to. The alerts

and notifications are system generated by the trigger of threshold values
configured by the system administrator.

Interactions Enables supervisors to automatically record and archive employee phone
conversations. You can capture periodic screen shots of the employee
desktop, and play back the recorded interaction for quality management
and monitoring.

Live Monitoring Enables supervisors and quality managers to monitor live interactions
between employee and customers to assess employee performance in
real-time, and provide instant online feedback and assistance.

Evaluate Enables supervisors and quality managers to review and evaluate
employee performance for both voice and nonvoice transactions. You can
create evaluation plans, build evaluation forms, calibrate evaluations, and
manage the appeals raised by the employees against the evaluations.

Coach Enables supervisors and managers to create personalized training plans
and feedback to help improve employee performance. You can define a list
of skills and improvement areas, assign coaching sessions for specific
groups or employees, and track improvements on team and individual
performance over time.

Table continues…

Navigation
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Name Description
Learn Enables supervisors and managers to train employees in the contact

center with course ware and quizzes to improve their efficiency and
enhance productivity. You can create task-specific quizzes and upload
training videos, slide presentations, multimedia, and other courseware and
assign them to selected employees for training.

Reports Enables supervisors and quality managers to generate on-demand and
scheduled reports for detailed information on interaction analytics, voice
configurations, employee performance, and quality trends.

Administration Provides administrative owners access to the organization, employee and
group configuration, call recording settings, queue management, account
configuration, and general settings.

Menus
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Chapter 3: Monitoring interactions in real
time

Live Monitoring
With the Live Monitoring module, supervisors and managers can silently monitor real time
interactions of employees to assess and measure performance. Supervisors and managers can
identify trouble areas and take immediate steps to ensure customer satisfaction.

The Live Monitoring module provides the following benefits:

• Ability to silently listen to agent and customer interactions in progress and view real-time agent
information and interaction status.

• Ability to respond to and mitigate caller objectives or complaints by providing instant feedback.

• Provision to create different views that define your search criteria to quickly access those live
interactions you wish to listen.

• Ability to customize various columns that help quickly identify important interaction details such
as extension, queue, tenure, call duration, current state, current state duration, ANI number
and so on.

• Provision to allow supervisors to perform QA while monitoring to measure agent performance
on aspects like average handling time and adherence to scripts provided by management. You
can also flag an interaction for further evaluation.

• Ability to email an interaction as a link to anyone.

Using the Live Monitoring module, authorized users can:

• Manage Views

• Monitor live interactions

• Play live interactions

Monitor Live Interactions
Supervisors and authorized users can view and monitor the live interactions of team members and
employees they have access to and provide timely feedback and coaching.

From the Silent Monitor page, you can:

• Assist new by providing immediate feedback when required.
• Track employees whose average handle time, hold count, or hold duration is high.

May 2016 Using Avaya Workforce Optimization Select 14
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


• View color coded interactions that are defined based on the interaction duration.
• Configure to listen to interactions of specific agents at regular intervals. The interaction will

automatically play in the order of selection.
• Customize the page to add columns that display interaction details such as extension, queue,

tenure, and duration.
• Filter your search on specific columns by using conditions and operators.
• Use the pagination option to specify how many records you wish to view per page.

Play Live Interactions
While playing a live interaction, you can perform the following actions:

• Record an interaction.
• Add comments and tags to an interaction.
• Provide feedback to employees about an interaction.

Supervisors or managers can subscribe to get relevant alerts about an employee whose average
handle time (AHT) or hold count is high. In such cases, the supervisor can listen to the live
interactions of those employees to respond and mitigate caller objectives or complaints.

Manage Views
Using Views, you can filter data by specific criteria.

Depending on the business requirement, you can create different Views with filters using logic
conditions. For example, to search for live interactions that have been put on hold a number of
times, you can define filters based on No of Holds, Interactions Id, and Reporting To with
operators Greater Than or Between. The View displays the interactions that match the search
criteria.

Note:

When you log in to the application the first time, the system displays the AWFOSView configured by
the system administrator. You can change the Default View or create a new Viewto search and play
desired interactions.

After you create a View, you can save it for later use.

You can do the following with Views:

• Create multiple filters.

• Use the default View that comes with a preconfigured set of parameters.

• Define the search criteria with a comprehensive list of parameters.

• Use operators to add multiple filters to use multiple parameters for a View.

• Use the option to display additional columns in the live interactions list.

• Share Views that you create with other users.

Manage Views

May 2016 Using Avaya Workforce Optimization Select 15
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


Related links
Adding a View on page 16
Setting up filters for a View on page 16
Configuring display fields for a View on page 17
Sharing a View on page 18
Adding a View field descriptions on page 19
Adding a View on page 33
Setting up filters for a View on page 16
Configuring display fields for a View on page 17
Sharing a View on page 18
Adding a View field descriptions on page 19

Adding a View
About this task
To search for live interactions, you can use the AWFOS DefaultView, a saved View or a View that
has been shared by other users. If you want a new set of filter criteria, you can create a new View.

Note:

The AWFOS DefaultView consists of predefined filters configured by your system administrator. You
cannot modify the filters on this View.

Procedure
1. Click Live Monitoring > Monitor.

2. Click Add.

3. On the Create View page, type a name and description.

Next steps
Set up filters for a View.

Related links
Manage Views on page 15

Setting up filters for a View
About this task
Using filters in the View, you can:

• Add multiple search parameters within a single filter criteria.
• Define multiple criteria using operators.
• Add multiple values to match a single parameter separated by commas.

Monitoring interactions in real time
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Procedure
1. In Field, select the field on which to apply the filter.

2. In Operator, select the operator for the filter.

3. In Value, enter the value that the records must match.

4. (Optional) To add multiple filters, click Add Field.

5. To save the View, click the Save & Close button.

Next steps
Configure display fields for a View.

Related links
Manage Views on page 15
Manage Views on page 15

Configuring display fields for a View
About this task
When you select a View, you can view the interaction details in the list. All the information on the
interaction is not displayed. If you do not see the specific fields you are looking for, you can
configure additional fields to display in the list.

Procedure
To move fields to the Assigned Fields list:

1. Select one or more fields from the Available Fields list.

a. To search a field, type the first few characters of the field name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

To remove fields from the Assigned Fields list:

2. Select one or more fields from the Assigned Fields list.

a. To search a field, type the first few characters of the field name in Search.

b. To move a single selection from the list, use the Remove Selected button.

c. To move multiple selections from lists, use the Remove All button.

Next steps
Share a View.

Related links
Manage Views on page 15
Manage Views on page 15

Manage Views
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Sharing a View
About this task
Use this procedure to share a View that you created so that other users can reuse the shared View
to search for interactions.

You can keep the saved View as private or share the View with specific employees, or everyone.
The selected users can see the shared View in their saved Views.

Procedure
1. From Share, select one of the following to share the View with other users:

• Me

• Selected Groups

• Everyone

2. To share the View with selected groups, select Selected Groups.

The system displays the Group and Employee search and select options.

3. Select one or more groups from the Available Groups list.

a. To search a group, type the first few characters of the group name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

4. To remove groups from the Assigned Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

5. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

6. To remove employees from the Assigned Employees list; select one or more employees and
use the Remove Selected and Remove All buttons.

7. Click Save and Close.

Related links
Manage Views on page 15
Manage Views on page 15

Monitoring interactions in real time
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Adding a View field descriptions
View

Name Description
Name The name of the View.

This field is mandatory.
Default The option to display the selected View as the default.
Description The description of the View.
Filter The filter criteria used to search the interactions.
Display Fields The columns displayed in the search results.
Share The option to share the View with selected users, with everyone, or save it

as private.

Filter

Name Description
Field The parameters used to filter the search results. The options are:

• DP OU Type

• Organization Units

• Site

• Groups

• Reporting To

• Employee Status

• Tenure

• Interactions Id

• Queues

• Duration

• Calling Party

• Called Party

• No of Holds

• No of Transfers

• Hold Duration

• Transaction Date

• Custom Transaction Date

• Commented

• Archived
Table continues…

Manage Views
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Name Description
• Extension

• Department

• Custom Fields

• Variables 1–10
Operators The operator used to specify the search criteria. The options are:

• Equals

• Not Equal To

• Contains

• Does not contain

• Starts with

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Between

• Includes

• Excludes
Value The value specified in the search query that is used to match the records.

You can view the list of interactions that match the value in this list.

Fields

Name Description
DP OU Type To search for interactions based on the organizational unit partition.
Organization Units To search for interactions based on the name of the organizational unit.

Use the available operators to search the interactions.

For example, when you use the Excludes operator and enter the name of
the organizational unit, a specific organizational unit is removed from the
search.

Site To search for interactions of employees belonging to the specified site.
Reporting to To search for interactions based on the name of the supervisor.

For example, to search for interactions monitored by a specific supervisor,
use the Contains operator and specify the supervisor name. The search
results display the interactions by all employees assigned under the
selected supervisor.

Groups To search for interactions of employees belonging to the specified group.

Table continues…

Monitoring interactions in real time
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Name Description
Employee Status To search for interactions based on the status of the employee. The

options are:
Tenure To search for interactions based on the tenure of the employee in weeks.
Custom Variables
Queues To search for interactions by the queue that the interaction is associated

with.
Duration To search by the duration of the interaction specified in the hh:mm:ss

format.
Calling Party To search by the extension number of the calling party.
Called Party To search by the extension number of the called party.

For example, to search for interactions of a specific employee, enter the
extension number of the employee.

No of Holds To search for interactions based on the number of times that the employee
put the interaction on hold.

No of Transfers To search for interactions based on the number of times that the employee
transferred the interaction.

Hold Duration To search for interactions based on the total duration for which the
employee put the interaction on hold, specified in the hh:mm:ss format.

Operators

Name Description
Equals To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Between To search for interactions that lie between the specified value.

Manage Views
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Display Fields

Name Description
Archived The option to indicate if the interaction is archived.
Extension The extension number of the employee who attended the interaction.
Department The name of the department that the employee belongs to.
DP OU Type The partition of the organizational unit, as set up by the system

administrator.
Organization Units The name of the organization unit that the employee belongs to.
Site The name of the site that the employee belongs to.
Reporting to The name of the supervisor or manager to whom the employee reports.
Groups The name of the group that the employee belongs to.
Employee Status The status of the employee attending to the interaction. The options are:
Queues The queue that the interaction is associated with.
Duration The duration of the interaction in the hh:mm:ss format.
Calling Party The extension number of the customer.
Called Party The extension number of the employee who is attending to the interaction.
No of Holds The number of times that the employee put the interaction on hold.
No of Transfers The number of times that the employee transferred the interaction.
Hold Duration The total duration for which the employee put the interaction on hold in the

hh:mm:ss format.
Is muted The live interaction that is muted.
Is masked The live interaction that is masked.
Custom Fields The interaction that consists of associated custom fields.

Share

Name Description
Me The option to set the ViewView as private where users will not be able to

view or use the View.
Selected Groups The option to share the View with specific people or groups.
Everyone The option to share the View with all users of the application.

By sharing the view with a group or everyone, the system renders results
based on the access the user with whom the view is shared. Users can
only view search results and cannot edit the search results.

Related links
Manage Views on page 15
Manage Views on page 15

Monitoring interactions in real time
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Viewing live interactions
About this task
On the Silent Monitor page, you can view and monitor the interaction of employees or team
members in real time.

When you select a View, the search results, display live interactions based on the filter criteria
defined for the View.

If the current View does not provide the appropriate search results, modify the search criteria in the
selected View, or create a new View.

Procedure
1. Click Live Monitoring > Monitor.

The system displays the live interactions in the default View.

2. From the View drop-down list, select a View.

The system displays all the live interactions for the search criteria defined under the selected
View.

3. View the basic details of the live interactions displayed in the columns.

4. To display or hide columns, click the  icon at the top of the list, and select or clear the
corresponding check boxes.

5. On the Pagination controls, choose the number of records that you want to view on each
page.

6. To filter the live interactions, click the  icon in the column by which you want to filter.

You can filter the live interaction by interaction ID, start time, end time, and other parameters
using the filters available in each column.

Note:

You can filter the live interactions by any number of available fields at the same time.

7. To sort the live interactions, click the  icon in the column by which you want to sort.

The upward arrow indicates sorting in the ascending order. The downward arrow indicates
sorting in the descending order.

Viewing live interactions field descriptions
Name Description
Interaction ID The unique ID of the interaction.

Table continues…
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Name Description
Employee The name of the employee who is attending to the interaction.
Organization Units The name of the organization unit that the employee belongs to.
Site The name of the site that the employee belongs to.
Groups The name of the group that the employee belongs to.
Department The name of the department that the employee belongs to.
Reporting To The name of the supervisor or manager to whom the employee reports.
Tenure The tenure of the employee in weeks.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
Call Duration The duration of the interaction in the hh:mm:ss format.
Current State The current interaction state whether the employee is talking or has put the

call on hold.
Current State Duration The duration of the current state of interaction.
Queue The queue that the interaction is associated with.
Queue-Queue Type The queue and queue type that the interaction is associated with.
Employee Status The status of the employee attending to the interaction. The options are:
ANI Number The phone number of the incoming call.
Recordings The field to indicate whether the interaction is enabled for recording.
Screen Title The title in the nonvoice interaction captured during monitoring of the

employee desktop on-screen activity.
Screen Captures The field to indicate whether the screen capture of the employee desktop is

enabled for recording.
Monitor Next Interaction of
the Selected Agents

The option to monitor interactions of selected employees. For example,
new employees whose AHT, hold count, and hold duration is high.

The next interaction of the selected employee automatically plays in the
Call Details page.

Monitor Selected Call Every
X seconds

The option to monitor selected interactions of employees at regular
intervals.

The interactions automatically play in the order of selection after every ‘X’
seconds, where ‘X’ is a set duration.

Icon Name Description
Play The live interactions that are available for monitoring.

Monitoring interactions in real time
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Adding a tag
About this task
Use tags to classify interactions or restrict specific actions on interactions.

When adding a tag, you can associate a specific action with the tag. For example, supervisors and
managers can use the Do not allow download tag to restrict download of recorded interactions.

Note:

You can create a new tag, and edit or delete existing tag if you have adequate permissions.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click Manage Interaction Tags to view the list of all available tags.

3. On the Call Details page, click Add Tags to create a tag.

4. Enter the appropriate details.

5. Click Save and Close.

Adding tags field descriptions
Name Description
Tags Name The name of the tag that you want to associate with an interaction.

Note:

You cannot view the operation of a tag while tagging the interaction.

Tag names must be given according to the operation defined on the tag.
Tags Description The description of the tag.
Operation The operation associated with the tag. The options are:

• Never delete the call: To tag interactions that you do not want anyone to
delete.

• Need training: To tag interactions of those employees who need
training.

• Do not allow download: To tag interactions that you do not want
anyone to download.

• Do not allow email: To tag interactions that you do not want anyone to
email.

• Do not allow download & email: To tag interactions that you do not
want anyone to download and email.

Status The status of the interaction tag. The options are:

Adding a tag
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Monitor live interactions

Playing live interactions
About this task
Supervisors and managers can monitor the live interactions of employees in real-time to respond
and mitigate customer objectives or complaints.

While monitoring a live interaction, you can:

• Record a live interaction.
• Provide feedback for a live interaction.
• Comment or tag a live interaction.

Procedure
1. Click Live Monitoring > Monitor.

2. On the Silent Monitor page, click the  icon next to the live interaction that you want to
monitor.

The system displays the Call Details page with the interaction streaming in the Live Monitor
panel.

Note:

The live monitoring of audio and screens is supported on browsers such as Internet
Explorer, Chrome, Safari and Firefox.

The time to view a live interaction depends on the browser you are using. You might notice
that in the Chrome browser, there is a slight delay experienced due to buffering of the
streaming videos during live monitoring.

3. In the Live Monitor panel, click one of the following:

• Start: To start recording the live interaction.
• Stop: To stop the recording the live interaction.

Note:

You can record a live interaction, only if you have the appropriate permissions.

4. To view the video with the screen captures in full screen, click the Full Screen (  ) icon.

To return to the original resolution and size of the screen shot, click the Fit to Width (  )
icon.

5. In the Profile tab, view the details of the employee who is handling the interaction.

6. To play the previous interaction, click the Previous ( ) icon.

7. To play the next interaction in the list, click the Next ( ) icon.

Monitoring interactions in real time
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Providing feedback for a live interaction
About this task
As a supervisor or manager monitoring live interactions, you can provide feedback to the agent
during the live call.

You can select the recipients and delivery method of the feedback message. The message is
delivered through email or as a notification message in the inbox of recipients.

Procedure
1. Click Live Monitoring > Monitor.

2. On the Silent Monitor page, click the  icon next to the live interaction that you want to
comment on.

3. On the Call Details page, click Feedback.

4. Enter the appropriate details in the fields.

5. Click Send.

The message is sent to all recipients as an email or a message in their notification inbox.

Adding comments to a live interaction
About this task
While monitoring an interaction in real time, supervisors and managers can add comments to
provide specific information about the interaction.

Procedure
1. Click Live Monitoring > Monitor.

2. On the Silent Monitor page, click the  icon next to the live interaction that you want to
comment on.

3. On the Call Details, click Comments/Tags.

4. In comments, enter a comment.

You can only update or delete the comments that you add. However, if you have access to
the interaction, then you can view all the comments made by others.

5. Click Submit.

Monitor live interactions

May 2016 Using Avaya Workforce Optimization Select 27
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


Tagging a live interaction
About this task
Supervisors can tag an interaction to enforce a set of predefined actions. While adding a tag, you
can associate one of the following predefined actions with the tag:

• Never delete the call
• Need training
• Do not allow download
• Do not allow email
• Do not allow download & email
• Flag for QA

Procedure
1. Click Live Monitoring > Monitor.

2. On the Playback page, click the  icon.

3. On the Call Details page, click Add Tags to create a tag.

4. Enter the appropriate details.

5. Click Save and Close.

Playing live interactions field descriptions
Profile

Name Description
Employee Code The employee ID of the person who is attending to the interaction.
Employee Name The name of the employee who is attending to the interaction.
Extension The extension number of the employee who is attending to the interaction.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
Current State The current interaction state indicating whether the employee is attending

to the interaction or has put the interaction on hold.
Current State Duration The duration of the current state of the interaction.
Groups The name of the group that the employee belongs to.
Location The name of the location that the employee belongs to.
Reporting To The name of the supervisor or manager to whom the employee reports.
Queue The queue that the interaction is associated with.

Monitoring interactions in real time
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Feedback

Name Description
Broadcast on The delivery mode by which the message is sent as feedback. The options

are:

• Email: To send the feedback message to the employees mentioned in
CC field and to the Agent mentioned in the To field.

• My Inbox: To send the feedback message to the notification inbox of the
selected employees.

Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
Extension The extension number of the employee who is attending to the interaction.
To The email id of the agent who is handling the call and which is configured

in the admin employee profile screen.
Subject The subject of the feedback message.
Message Type The type of message to be delivered to the recipients. The options are:

• Notifications: To send feedback as a notification message.

• Alert: To send feedback as an alert.

• Information: To send feedback as an information message.
Agent Name The name of the employee who is attending to the interaction.
From The email id of the supervisor who is sending the feedback.
CC The email id of employees to whom a copy of the feedback is sent.
Comments The text message sent as feedback for the live interaction.

Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.
Actions The option to edit or delete a comment.

Tags

Name Description
Date The date on which the tag is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
From The name of the employee who adds the tag.
Never delete the call The tag used to specify that the interaction should never be deleted.
Need training The tag used to specify that the employee attending to the interaction

requires further training.

Table continues…

Monitor live interactions
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Name Description
Do not allow download The tag used to specify that the interaction cannot be downloaded.
Do not allow download &
email

The tag used to specify that the interaction cannot be downloaded or sent
by email.

Actions The option used to delete a tag.

Note:

The deleted tag must not affect the interaction.

Monitoring interactions in real time
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Chapter 4: Managing recorded interactions

Interactions
Using the Interactions module, authorized users can view and manage interactions of the
employees that they have access to. During interaction playback, the supervisor can view details of
each segment of an interaction to determine if the call was transferred or put on hold.

Note:

With appropriate permissions, employees can also view their own interactions.

The Interactions module provides the following benefits:

• Provision to playback recorded interactions to listen to them. Supervisors can pick interactions
that need attention and monitor them depending on AHT, hold duration, and other such
information.

• Ability to add comments to a recorded interaction especially when the Supervisor wants to
provide important information to the evaluator or reviewer.

• Ability to download a recorded interaction in WAV, MP4 (Audio and Screens), and MP4
formats.

• Provision to use existing tags or create one to apply to an interaction. Using tags, you can
restrict specific actions on interactions such as downloading or deleting of interactions.

• Provision to create different views to define your search criteria. You can take advantage of
Views to quickly access those interactions you frequently view and listen.

• Ability to customize the Interactions page with various columns that help quickly identify
important interaction details such as interaction start time, interaction end time, duration, who
ended the interaction (customer or agent), number of holds, number of transfers, hold duration,
and so on.

• Visual depiction of conversation graphs that provide quick identification of problem areas such
as cross-talk or elevated voices.

• Availability of all interaction segments such as conference, transfers, and so on. You can also
view caller experience details.

Using the Interactions module, authorized users can:

• Manage Views
• View recorded interactions
• Play recorded interactions
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View recorded interactions
Supervisors can view and monitor recorded interactions and get a quick snapshot of how the team
members are performing.

You can view and track recorded interactions to:

• Listen and assess recorded interactions of new hires.
• Identify employees whose average handle time and hold count is high.
• View the number of interactions handled by each employee, comments added to interactions,

and interactions that are already played.
• Customize the page to add columns that display interaction details such as extension, queue,

tenure, and duration.
• Filter your search on specific columns by using conditions and operators.
• Use the pagination option to specify how many records you want to view per page.

Play recorded interactions
The Avaya Workforce Optimization Select application automatically records interactions and
captures screen shots of agent’s desktop which appear when playing back an interaction.

While listening to a recorded interaction, you can:

• Add comments to provided information to the evaluator or reviewer.
• Download a recorded interaction in WAV, MP4 (Audio only), and MP4 formats.
• Tag a recorded interaction.
• View the conversation graph that provides quick identification of problem areas such as cross

talk or elevated voices.

Manage Views
Using Views, you can filter data by specific criteria.

Depending on the business requirement, you can create different Views with filters using logic
conditions. For example, to search for live interactions that have been put on hold a number of
times, you can define filters based on No of Holds, Interactions Id, and Reporting To with
operators Greater Than or Between. The View displays the interactions that match the search
criteria.

Note:

When you log in to the application the first time, the system displays the AWFOSView configured by
the system administrator. You can change the Default View or create a new Viewto search and play
desired interactions.

After you create a View, you can save it for later use.

Managing recorded interactions
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You can do the following with Views:

• Create multiple filters.

• Use the default View that comes with a preconfigured set of parameters.

• Define the search criteria with a comprehensive list of parameters.

• Use operators to add multiple filters to use multiple parameters for a View.

• Use the option to display additional columns in the live interactions list.

• Share Views that you create with other users.

Related links
Adding a View on page 16
Setting up filters for a View on page 16
Configuring display fields for a View on page 17
Sharing a View on page 18
Adding a View field descriptions on page 19
Adding a View on page 33
Setting up filters for a View on page 16
Configuring display fields for a View on page 17
Sharing a View on page 18
Adding a View field descriptions on page 19

Adding a View
About this task
Use the View to search for interactions based on the filters you specify.

By default, the AWFOS DefaultView comes with a set of pre defined filters configured by the system
administrator. You cannot modify the filters on the AWFOS DefaultView.

Procedure
1. Click Interactions > Playback.

The system displays the interactions in the default View.

2. Click Add to create a new View to display interactions that match your required criteria.

The system displays the Create View page where you can define the filter criteria and save
the View.

3. In Name, enter the name of a View.

4. In Description, enter the description of a View.

Next steps
Set up filters for a View.
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Related links
Manage Views on page 15

Setting up filters for a View
About this task
Using filters in the View, you can:

• Add multiple search parameters within a single filter criteria.
• Define multiple criteria using operators.
• Add multiple values to match a single parameter separated by commas.

Procedure
1. In Field, select the field on which to apply the filter.

2. In Operator, select the operator for the filter.

3. In Value, enter the value that the records must match.

4. (Optional) To add multiple filters, click Add Field.

5. To save the View, click the Save & Close button.

Next steps
Configure display fields for a View.

Related links
Manage Views on page 15
Manage Views on page 15

Configuring display fields for a View
About this task
When you select a View, you can view the interaction details in the list. All the information on the
interaction is not displayed. If you do not see the specific fields you are looking for, you can
configure additional fields to display in the list.

Procedure
To move fields to the Assigned Fields list:

1. Select one or more fields from the Available Fields list.

a. To search a field, type the first few characters of the field name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

To remove fields from the Assigned Fields list:
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2. Select one or more fields from the Assigned Fields list.

a. To search a field, type the first few characters of the field name in Search.

b. To move a single selection from the list, use the Remove Selected button.

c. To move multiple selections from lists, use the Remove All button.

Next steps
Share a View.

Related links
Manage Views on page 15
Manage Views on page 15

Sharing a View
About this task
Use this procedure to share a View that you created so that other users can reuse the shared View
to search for interactions.

You can keep the saved View as private or share the View with specific employees, or everyone.
The selected users can see the shared View in their saved Views.

Procedure
1. From Share, select one of the following to share the View with other users:

• Me

• Selected Groups

• Everyone

2. To share the View with selected groups, select Selected Groups.

The system displays the Group and Employee search and select options.

3. Select one or more groups from the Available Groups list.

a. To search a group, type the first few characters of the group name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

4. To remove groups from the Assigned Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

5. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.
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6. To remove employees from the Assigned Employees list; select one or more employees and
use the Remove Selected and Remove All buttons.

7. Click Save and Close.

Related links
Manage Views on page 15
Manage Views on page 15

Adding a View field descriptions
View

Name Description
Name The name of the View.

This field is mandatory.
Default The option to display the selected View as the default.
Description The description of the View.
Filter The filter criteria used to search the interactions.
Display Fields The columns displayed in the search results.
Share The option to share the View with selected users, with everyone, or save it

as private.

Filter

Name Description
Field The parameters used to filter the search results. The options are:

• DP OU Type

• Organization Units

• Site

• Groups

• Reporting To

• Employee Status

• Tenure

• Interactions Id

• Queues

• Duration

• Calling Party

• Called Party

• No of Holds
Table continues…
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Name Description
• No of Transfers

• Hold Duration

• Transaction Date

• Custom Transaction Date

• Commented

• Archived

• Extension

• Department

• Custom Fields

• Variables 1–10
Operators The operator used to specify the search criteria. The options are:

• Equals

• Not Equal To

• Contains

• Does not contain

• Starts with

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Between

• Includes

• Excludes
Value The value specified in the search query that is used to match the records.

You can view the list of interactions that match the value in this list.

Fields

Name Description
DP OU Type To search for interactions based on the organizational unit partition.
Organization Units To search for interactions based on the name of the organizational unit.

Use the available operators to search the interactions.

For example, when you use the Excludes operator and enter the name of
the organizational unit, a specific organizational unit is removed from the
search.

Table continues…
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Name Description
Site To search for interactions of employees belonging to the specified site.
Reporting to To search for interactions based on the name of the supervisor.

For example, to search for interactions monitored by a specific supervisor,
use the Contains operator and specify the supervisor name. The search
results display the interactions by all employees assigned under the
selected supervisor.

Groups To search for interactions of employees belonging to the specified group.
Employee Status To search for interactions based on the status of the employee. The

options are:
Tenure To search for interactions based on the tenure of the employee in weeks.
Custom Variables
Queues To search for interactions by the queue that the interaction is associated

with.
Duration To search by the duration of the interaction specified in the hh:mm:ss

format.
Calling Party To search by the extension number of the calling party.
Called Party To search by the extension number of the called party.

For example, to search for interactions of a specific employee, enter the
extension number of the employee.

No of Holds To search for interactions based on the number of times that the employee
put the interaction on hold.

No of Transfers To search for interactions based on the number of times that the employee
transferred the interaction.

Hold Duration To search for interactions based on the total duration for which the
employee put the interaction on hold, specified in the hh:mm:ss format.

Operators

Name Description
Equals To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.

Table continues…
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Name Description
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Between To search for interactions that lie between the specified value.

Display Fields

Name Description
Archived The option to indicate if the interaction is archived.
Extension The extension number of the employee who attended the interaction.
Department The name of the department that the employee belongs to.
DP OU Type The partition of the organizational unit, as set up by the system

administrator.
Organization Units The name of the organization unit that the employee belongs to.
Site The name of the site that the employee belongs to.
Reporting to The name of the supervisor or manager to whom the employee reports.
Groups The name of the group that the employee belongs to.
Employee Status The status of the employee attending to the interaction. The options are:
Queues The queue that the interaction is associated with.
Duration The duration of the interaction in the hh:mm:ss format.
Calling Party The extension number of the customer.
Called Party The extension number of the employee who is attending to the interaction.
No of Holds The number of times that the employee put the interaction on hold.
No of Transfers The number of times that the employee transferred the interaction.
Hold Duration The total duration for which the employee put the interaction on hold in the

hh:mm:ss format.
Is muted The live interaction that is muted.
Is masked The live interaction that is masked.
Custom Fields The interaction that consists of associated custom fields.

Share

Name Description
Me The option to set the ViewView as private where users will not be able to

view or use the View.
Selected Groups The option to share the View with specific people or groups.
Everyone The option to share the View with all users of the application.

By sharing the view with a group or everyone, the system renders results
based on the access the user with whom the view is shared. Users can
only view search results and cannot edit the search results.
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Related links
Manage Views on page 15
Manage Views on page 15

Viewing recorded interactions
About this task
On the Playback page, you can view and play the recorded interactions of employees or team
members that you have access to.

When you select a View, the search results display interactions based on the filter criteria defined
for the View.

If the current View does not provide the appropriate search results consider modifying the search
criteria in the selected View, or create a new View.

Procedure
1. Click Interactions > Playback.

2. From the View drop-down, select a View to filter the list of interactions.

3. View the basic details of each interaction displayed in the columns.

4. On the Pagination controls, choose the number of records you want to view on each page.

5. To filter the interactions, click the Filter icon (  ) in the column by which you want to filter.

You can filter the interaction by interaction ID, start time, end time, and other parameters
using the filters available in each column. You can use And, and Or operators to add
multiple search conditions.

Note:

Filter can be applied on two fields at the same time.

6. To sort interactions, click the Sort icon in the column on which you want to sort the
interaction.

The upward arrow indicates sorting in the ascending order. The downward arrow ( )
indicates sorting in the descending order.
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Viewing recorded interactions field descriptions
Name Description
Interaction ID The unique ID of the interaction.
Employee The name of the employee who attended to the interaction.
Reporting To The name of the supervisor or manager to whom the employee reports.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
Duration The duration of the interaction in the hh:mm:ss format.
Queue The queue that the interaction is associated with.
DP OU Type The partition of the organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
Organization Units The name of the organization unit that the employee belongs to.
Site The name of the site that the employee belongs to.
Groups The name of the group that the employee belongs to.
Tenure The tenure of the employee in the organization, in weeks.
Called Party To search by the extension number of the called party.
Calling Party To search by the extension number of the calling party.
No of Holds The number of times that the employee put the interaction on hold.
No of Transfers The number of times that the employee transferred the interaction.
Hold Duration The total duration for which the employee put the interaction on hold in the

hh:mm:ss format.
Screen Captures The field to indicate if the interaction has screens captures. The options

are:

• Yes

• No
Department The name of the department that the employee belongs to.
Who Ended the Interaction The person who ended the interaction.

• Employee

• Customer
Transaction Date The date on which the interaction is recorded.
Custom Transaction Date The custom date field used to specify the date on which the interaction is

recorded.
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Icon Name Description
Play The interaction that is available to play for monitoring and evaluation.

Viewed The interaction that is viewed by the supervisor or manager for monitoring.
The number on the icon indicates the number of times the interaction has
been viewed.

Evaluated The interaction that is evaluated by the supervisor or manager.

Commented The interaction that is commented on by the supervisor or manager. The
number on the icon indicates the total number of comments received on
the interaction.

Adding a tag
About this task
Use tags to classify interactions or restrict specific actions on interactions.

When adding a tag, you can associate a specific action with the tag. For example, supervisors and
managers can use the Do not allow download tag to restrict download of recorded interactions.

Note:

You can create a new tag, and edit or delete existing tag if you have adequate permissions.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click Manage Interaction Tags to view the list of all available tags.

3. On the Call Details page, click Add Tags to create a tag.

4. Enter the appropriate details.

5. Click Save and Close.

Adding tags field descriptions
Name Description
Tags Name The name of the tag that you want to associate with an interaction.

Note:

You cannot view the operation of a tag while tagging the interaction.
Table continues…
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Name Description
Tag names must be given according to the operation defined on the tag.

Tags Description The description of the tag.
Operation The operation associated with the tag. The options are:

• Never delete the call: To tag interactions that you do not want anyone to
delete.

• Need training: To tag interactions of those employees who need
training.

• Do not allow download: To tag interactions that you do not want
anyone to download.

• Do not allow email: To tag interactions that you do not want anyone to
email.

• Do not allow download & email: To tag interactions that you do not
want anyone to download and email.

Status The status of the interaction tag. The options are:

Manage interactions

Playing recorded interactions
About this task
During an enquiry, customer dispute, or non compliance issue, as a supervisor or manager you can
listen to the recorded interaction and view the associated on screen activity.

While listening to a recorded interaction, you can:

• Comment or tag a recorded interaction to provide information to evaluator or reviewer.
• Email a recorded interaction.
• Download a recorded interaction in different formats.
• Evaluate a recorded interaction.
• View previous evaluation comments.
• View interaction segments.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the Play ( ) icon.

3. On the Call Details page, in the Recorder panel, click one of the following:

• Play: To listen to the recorded interaction.
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• Stop: To stop the recorded interaction.

• Pause: To stop the playback of a recording and resume from where it stopped.

4. In the Call Details tab, view the interaction details.

Adding comments to an interaction
About this task
Supervisors and managers can add comments to a recorded interaction.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon.

3. On the Call Details, click Comments/Tags.

4. In comments, enter a comment.

You can only update or delete the comments that you add. However, if you have access to
the interaction, then you can view all the comments made by others.

5. Click Submit.

Tagging an interaction
About this task
Supervisors can tag an interaction to enforce the following set of predefined actions:

• Never delete the call
• Need training
• Do not allow download
• Do not allow email
• Do not allow download & email
• Flag for QA

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon.

3. On the Call Details, click the Comments/Tags tab to tag an interaction.

4. From the Tags list, select the tag.

5. Click Set.
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Emailing an interaction
About this task
You can email an interaction if you want other users to view or listen to the interaction. The
interaction is sent as a link, and the user must log on to the application to access the interaction.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon next to the interaction that you want to play.

3. On the Call Details page, click the Email ( ) icon.

4. Enter the message, recipient details, and click Send.

Downloading an interaction
About this task
Supervisors and managers can download interactions in WAV, MP4 (audio only), and MP4 (audio
and screens) formats. Use the MP4 (audio and screens) option only to download interactions with
screens and for nonvoice interactions.

You can directly download the WAV file to your local machine. The MP4 (audio only) and MP4
(audio and screens) formats are available to download from the Media Downloads page.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon next to the interaction that you want to play.

3. On the Call Details page, click the Download (  ) icon.

4. On the Download page, type appropriate comments for the interaction.

5. Select the format in which you want to download.

• WAV: To download the interactions with recorded voice.

• MP4 (Audio Only): To download the interactions with recorded voice.

• MP4 (Audio and Screens) : To download interactions with screens and for nonvoice
interactions.

6. Click Submit.
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Viewing Evaluations
About this task
Use this procedure to view evaluations on the interactions when you listen or view the interaction,
and before you begin evaluating the interaction.

Procedure
1. On the Call Details page, click the Evaluations tab.

2. Click the (>) icon to view the details of the evaluation scores that was received for the
interaction.

3. To evaluate the interaction, click Evaluate Now.

The system displays a blank form name and evaluation type if you are evaluating the
interaction for the first time.

Viewing interaction segments
About this task
Use this procedure to view all the segments of the interaction, including interaction transfers,
conferences, and the duration for which the interaction was put on hold.

Procedure
1. On the Call Details page, click the Segmentation tab.

2. In Customer Interaction Across Segments, view the details of the interaction across
segments.

3. In Segmentation Overview, click on the segment of the interaction that you want to listen to
or view.

The segment of the interaction plays in the Recorder pane.

Call details field descriptions
Call Details

Name Description
Interaction ID The unique ID of the interaction.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
Duration The duration of the interaction in the hh:mm:ss format.

Table continues…
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Name Description
Employee Code The employee code of the agent who attended to the interaction.
Employee Name The name of the employee who attended to the interaction.
Extension To search by the extension number of the called party.
Site The name of the site that the employee belongs to.

The system administrator associates employees working in different
locations to the relevant sites. Supervisors and managers can monitor
interactions of employees based on the Site to which they belong to.

Reporting To The name of the supervisor or manager to whom the employee reports.
Screen The field to indicate whether the screen capture is enabled for recording.
Number of Holds The number of times that the employee put the interaction on hold.
Hold Duration The total duration for which the employee put the interaction on hold in the

hh:mm:ss format.
Number of Transfers The number of times that the employee transferred the interaction.

Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.
Actions The option to edit or delete a comment.

Tags

Name Description
Date The date on which the tag is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
From The name of the employee who adds the tag.
Never delete the call The tag used to specify that the interaction should never be deleted.
Need training The tag used to specify that the employee attending to the interaction

requires further training.
Do not allow download The tag used to specify that the interaction cannot be downloaded.
Do not allow download &
email

The tag used to specify that the interaction cannot be downloaded or sent
by email.

Email

Name Description
From The email address of the sender.

Table continues…
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Name Description
To The email address of the user to whom you want to mail the interaction.
Subject The subject of the email.
Comments The body of the email.
Agent Name The name of the agent who handled the interaction.
Interaction Id The interaction ID that is unique to every interaction.
Extension The phone extension number of the agent who handled the interaction.
Interaction Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
CC The email address of the employee to whom you want to mail a copy of the

interaction.

Evaluations

Name Description
Form The evaluation form based on which the evaluation is performed.
Reviewer The name of the supervisor or manager who evaluated the interaction.
Evaluation Type The name denoting the type of evaluation.

For example, Normal, Adhoc, or Training to indicate the purpose or
category of evaluation.

Score The score received by the employee during evaluation of the interaction.
Evaluation Date The date on which the evaluation is performed.
Course/Quiz The course or quiz that was assigned to the employee based on the

previous evaluation scores.
Evaluation Modified Date The date on which the evaluation was modified for the previous evaluation.

Segmentation

Name Description
Total Customer Call
Duration

The total duration of the interaction handled by the employee including the
hold time and time to transfer the interaction.

Customer Interaction Across
Segments

The time on each segment of the interaction including transfer and
conferences of the interaction with other employees or agents.

Start Time The start time of the interaction in a 24–hour format: mm:dd:yyyy
hh:mm:ss.

End Time The end time of the interaction in a 24–hour format: mm:dd:yyyy hh:mm:ss.
Dialed From To search by the extension number of the called party.

For example, to search for interactions of a specific employee, enter the
extension number of the employee.

Dialed To To search by the extension number of the calling party.
Total Duration The total duration of the interaction in a 24–hour format: hh:mm:ss format.
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Name Description
Total Hold Duration The total duration for which the interaction was put on hold in in a 24–hour

format: hh:mm:ss format.
Total Transfers The total number of times that the interaction is transferred by the

employee.
Total Holds The total number of times that the interaction is put on hold by the

employee.
Total Conferences The total number of times that the interaction is put on conference by the

employee.

Viewing media downloads
About this task
Use this procedure to view the status of interactions you requested for download.

The Downloads window displays the details of the downloaded interactions and interactions that are
queued for download such as file name or record ID, start and end time, status, and the request
date of the downloaded interaction. You can click the Download button to download the interaction
and save it to your local machine.

Interactions with only audio recorded are downloaded in the WAV and MP4 format. Interactions with
screen captures and audio are downloaded in the MP4 format. Audio and screen recordings are
encrypted for security purposes.

Procedure
1. In the top-right corner of the Home page, click My Profile.

2. Click Media Downloads.

The system displays the Downloads window with the details of the download request.

3. Use the Pagination controls to navigate through the download list. You can choose the
number of records that you want to view on each page.

4. Filter the interactions by the interaction ID, start time, end time, and the download request
date.

5. Click Refresh to view the change in status of the interaction downloads.

Media downloads field descriptions
Name Description
Interaction ID The unique ID of the interaction.

Table continues…

Viewing media downloads

May 2016 Using Avaya Workforce Optimization Select 49
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


Name Description
Download The link to download an interaction.
Media Type The format in which the interaction is downloaded. The options are:

• WAV: To download the interaction audio in WAV format.

• MP4 (Audio Only): To download the interaction audio in MP4 format.

• MP4 (Audio and Screens): To download the recorded interaction video
and audio in MP4 format.

Status The status of the request to download the interaction. The options are:

• New: A download request that is new.

• Queued: A download request that is in queue.

• In Progress: A download request that is in progress.

• Completed: A download request that has completed successfully.

• Failed: A download request that has failed due to some reason.
Start Time The start time of the interaction download request, specified in a 24–hour

format: hh:mm:ss.
End Time The end time of the interaction download request, specified in a 24–hour

format: hh:mm:ss.
Requested Date The date on which the interaction download was requested.
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Chapter 5: Evaluating interactions

Evaluate
The Evaluate module in Avaya Workforce Optimization Select provides an easy-to-use, and flexible
solution for developing quality management in a contact center.

Quality managers can effectively evaluate employees by monitoring their interaction with customers
in the contact center.

The interactions provide valuable information about employee performance such as:

• Customer handling skills
• Sales techniques
• Product and service knowledge
• Technical skills for effective customer service
• Knowledge of corporate process and procedures
• Adherence to policies and rules

Using the Evaluate module, you can review and evaluate agent performance.

Evaluation process checklist
This checklist provides the high-level process for creating and managing evaluations.

No. Task Description Notes

1 Build an Evaluation Form
with flexible criteria and
scoring.

Evaluation forms comprise of
criteria, scoring patterns, and
score weightage options.

See Defining an evaluation
form on page 56.

2 Set up the Evaluation
Plan.

Evaluation plan is a mechanism
to automate the process of
selecting interactions using
predefined criteria and assigning
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No. Task Description Notes

interactions to reviewers to
evaluate. See Defining an
evaluation plan on page 72.

3 Evaluate interactions
assigned through the
Evaluation Plan

With Evaluation Forms, you can
evaluate and score interactions.
See Evaluating an interaction on
page 84

4 Manage the workflow of
appeals and
reevaluations.

With Appeals, you can automate
the process of raising, reviewing,
and approving appeals. See 
Appeals workflow on page 68

5 Calibrate evaluations to
ensure all evaluators
provide consistent
scoring and evaluations.

Calibrations allow multiple
evaluators to assess a single
interaction to ensure consistency
in quality. See Calibrating
evaluations on page 95.

6 Generate and download
reports as needed.

With Reports, you can assess
and report on individual, group,
and overall contact center
performance. See Reports on
page 123.

Building an evaluation form

Evaluation form checklist
This checklist provides the high-level process for creating and managing an evaluation form.

No. Task Reference Notes

1 Create Response Sets to
define scoring variables
for reviewers and
evaluators to score an
employee against an
evaluation criterion.

See Response Sets on
page 53.

2 Build evaluation forms
with flexible criteria and

See Defining an evaluation
form on page 56.
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No. Task Reference Notes

scoring to track the
quality of an interaction.

3 Add header information
to enable the evaluator to
enter additional
information about the
interaction being
evaluated.

See Defining Headers In
An Evaluation Form on
page 57.

4 Add parent and child
criteria to determine the
measures on which the
interaction must be
evaluated.

See Defining criteria for
evaluation on page 57.

5 Define the evaluating
mechanism as weighted
or nonweighted.

See Defining scoring
options on page 58.

Response Sets
Response Sets are scoring variables that you can use to score agents against a criteria. Response
sets can range from being a Yes/No/NA or Comply/Does not comply to a grading scale of 1 to 5.
You can choose a response set while building an evaluation form to define a scoring variable for a
criteria.

For example, assume that you have a criteria to measure whether or not an agent greets the
customer. The response set for the criteria can be Yes or No. Hence, depending on the questions
you create for every criteria, you can determine the different response sets you want to add.

When you modify a response set, the changes are reflected in the evaluation form only when you
again pick the response set against a criteria. Else, the previous response set is considered. You
cannot delete a response set if there are evaluations associated to the response set.

Viewing Response Sets
About this task
Use the Response Sets page to view the list of response sets that you created or have access to.

In the list, you can view the details of whether a Response Set is used in an evaluation form and in
evaluations for scoring interactions.

To filter Response Sets, use the sort and filter options in the list.

You can add a new Response Set or edit and delete an existing Response Set if you have adequate
permissions.
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Procedure
1. Click Evaluate > Setup > Response Sets.

The system displays the list of Response Sets.

2. View the details of the Response Set in the list.

If the response set is used in an evaluation form, the status is Yes in the Has Evaluations?
column.

3. To filter the response sets, click the Filter ( ) icon in the column by which you want to filter.

4. To edit a response set, click on the desired row.

5. To delete a response set, click Delete.

You can delete a Response Set only if it is not being used in any evaluation forms.

Viewing a Response Sets field descriptions
Name Description
Response Set The name used to identify the Response Set used in an evaluation form.
Status The field to indicate whether the Response Set is active and available

during evaluations. The options are:

• Active: the Response Set is available when a new form is being built.

• Inactive: the Response Set is unavailable when a new form is being
built.

Description The description of the Response Set.

You can use the option to provide reasons for adding a response set or
important information about the response set you create for future
reference.

Evaluations Performed The field used to identify whether there are evaluations performed using
the Response Set. The options are:

• Yes

• No
Has Forms The field used to identify whether the Response Set is used in any

evaluations. The options are:

• Yes

• No

Icon Name Description
Add To add a new Response Set.
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Adding a Response Set
Procedure

1. Click Evaluate > Setup > Response Sets.

The system displays the list of Response Sets.

2. On the Response Sets page, click Add.

3. On the Add Response Sets page, enter the appropriate details.

4. Click one of the following:

• Save & Add Another: To save the Response Set that you created and add another
response.

• Save & Close: To save the Response Set that you created.

Adding a Response Set field descriptions
Name Description
Response Set Name The name used to identify the Response Set used in an evaluation form.
Control Type The type of control used to display options in an evaluation form. The

options are:

• List Box: To create a drop down list of items for the user to select. Use
this option when you have many values as the values will be collapsed.

• Radio Button: To display options in the form of radio buttons. Use this
option when you have values in small numbers and you want to display
all the options.

Responses The option used to specify the responses to the evaluation criteria defined
in an evaluation form.

You can add more than one responses to the set.
Description The description of the Response Set.
Active The option to select the Response Set as active and available when

creating an evaluation form.

Evaluation forms
Evaluation Forms are instruments that you can use to track the quality of an interaction.

Building an evaluation form involves the following tasks:

• Configure the re-evaluation lock-out time to specify the number of days after which the
evaluation cannot be edited. Configure the appeals lock-out time to specify the number of
days, post evaluation, after which the employee cannot raise an appeal.

• Configure options that enable the evaluator to enter additional information about the interaction
being evaluated.

• Enforce the evaluator to feed comments while evaluating an interaction.
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• Associate departments, queues, and organization units to an evaluation form. Interactions of
agents belonging to only these associations can be evaluated using the evaluation form.

• Add parent and child criteria to determine the measures on which the interaction must be
evaluated. You can associate a response set (scoring variable) to a criterion. You can set a
response for conditional branching to define if a particular response must trigger additional
questions. You cannot associate scores to the additional questions. However, the responses to
the additional questions facilitate the evaluator in deciding whether to award a bonus or
penalty.

• Define scoring options like bonus, penalty, exclude from scores, and not applicable. You can
add a bonus or penalty at the parent criteria level, child criteria level, or at the overall
evaluation form level. The bonus or penalty will be a part of the overall score that is calculated
for an evaluated interaction. Use the exclude from score option if you do not want to tie any
score to a response. Use the not applicable option to restrict the user from adding a bonus or
penalty to a response.

• Assign courses or quiz to agents based on the response of the evaluator.
• Define the evaluating mechanism as weighted or nonweighted. If you select nonweighted, the

scores achieved at the child criteria level rolls up to the parent criteria. The overall score is a
sum of all scores achieved against the criteria. If you select the weighted option, you must
define weights for every criteria. Weights defined at every criteria node (parent or child) must
sum up to 100. The score achieved at the criteria will be a product of the raw score and the
weight.

Creating an evaluation form
Defining an evaluation form

Procedure
1. Click Evaluate > Setup > Forms

2. Click Add.

3. Enter a name and description for the help text displayed with the form.

4. Enter the number of days after which the user cannot edit the evaluation.

5. Enter the number of days post evaluation, after which the user cannot raise an appeal.

6. Select General Comments Mandatory if you want to make it mandatory for the evaluators
to feed general comments while evaluating the interaction.

7. Select a Queue Type. The evaluation form is available for selection when the user evaluates
interactions of agents belonging to the Queue.

8. Select a Department. The evaluation form is available for selection when the user evaluates
interactions of agents belonging to the Department.

9. If data partition is configured by the system administrator, select the DP OU. The evaluation
form is available for selection when the user evaluates interactions of agents belonging to
the data partitioned OU.

10. Select Organization Units and OU Type. The evaluation form is available for selection
when the user evaluates interactions of agents belonging to the Organization Unit.
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Next steps
Add header information in the evaluation form.

Adding headers in an evaluation form
About this task
Use the header information to capture additional details about the interaction. You can use control
types such as radio button, single select, or text box to predefine how you would want to capture the
information.

Procedure
1. In Field Name, enter the name for the header.

2. In Control Type, select the following options:

• Radio Button

• Single Select

• Text Box

3. In Options, enter the options for the user to select.

To add multiple options, click Add.

4. In Display Order, select the order in which the fields appear as header names in the
specified sequence while evaluating.

5. For the fields to display in the evaluation form, enable the field as Active.

6. Enter optional details in the evaluation form headers.

Next steps
Define evaluation form criteria.

Defining criteria for evaluation
Procedure

1. Click Add Criteria to enter the name and description for a parent criteria.

2. Click Add Child against the corresponding parent criterion.

Note:

You can also create multiple parent criteria first and then create one or more child criteria for
each parent criterion.

3. Enter a sub-criteria name and description and click Save.

The system displays the Responses and Comments tab.

4. Click Add Responses to add a response set.

5. In the Responses tab, specify the type of response, scoring conditions, and conditional
branching based on which the interaction is evaluated.

a. In Response Set, select a response set.
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The system displays the options defined for the response set.

b. Select the scoring conditions for each response.

c. Specify a score and a bonus or penalty.

d. Add conditional branching for a response, if required.

e. Assign a course or quiz for each response, and click Set.

Next steps
Add weightages.

Adding weightages
About this task
You can define the evaluating mechanism as weighted and nonweighted. If you select nonweighted,
the scores achieved at the child criteria level rolls up to the parent criteria. The overall score is a
sum of all scores achieved against the criteria. If you select the weighted option, you must define
weights for every criteria. Weights defined at every criteria node (parent or child) must sum up to
100. The score achieved at the criteria will be a product of the raw score and the weight.

Procedure
1. Select the Scoring Options as:

• Non Weighted Scores

• Weighted Scores

2. To calculate scores based on weights, perform the following steps:

a. In Formula, enter the formula for calculating the final scores.

The formula can only be defined at the criteria level.

b. For each of the criteria and child criteria, specify the weightage as a percentage value.

The parent criteria scores is the sum of all sub criteria level weights.

The sum of weighted scores of child criteria will roll up to the parent criteria and on that
sum the system applies the weight assigned to that parent criterion. Weights defined at
every criteria node (parent or child) must sum up to 100.

Next steps
Preview the evaluation form.

Previewing the evaluation form
Before you begin
Assign weights for scoring evaluation criteria

About this task
Use this procedure to review all the sections, criteria and child criteria and the scoring mechanism
chosen along with the scores in the evaluation form. The form will appear as it is displayed in the
evaluation form preview, when you evaluate an agent or employee.
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If you want to edit the evaluation form, you can go back to the respective screen and modify any of
the sections.

Procedure
1. Complete the mandatory steps under the Definition, Criteria, and Weights tabs.

2. On the Preview tab, view the details of the evaluation form.

3. Click Test Form to validate if the evaluation form is complete and ready to be saved or
published.

4. Click Save to save the evaluation form for future use.

The system displays the evaluation forms in the list under the Forms page with status as
Active.

5. Click Publish to run the evaluation form immediately.

The evaluation form is available for evaluators to evaluate.

Evaluation form field descriptions
Definition

Name Description
Name The name of the evaluation form.

This field is mandatory.
Help Text The help text that is displayed for the evaluation form.
Re-Evaluation Lockout Time
(Days)

The number of days from the date of first evaluation after which the
interaction cannot be reevaluated using the form.

Appeal Lockout Time (Days) The number of days from the evaluation date after which an appeal cannot
be raised using the form.

General Comments
Mandatory

The field for the user to enter comments while evaluating an interaction.

Default The option to set the evaluation form as default for all evaluations.

Note:

This field is available after you save the form.
Active The option to mark the form as active and available for employee

evaluations.

Note:

This field is available after you save the form.
Department The option to select a department. The evaluation form is available for

selection when the user evaluates interactions of agents belonging to the
Department.

Queue Type The option to select a queue. The evaluation form is available for selection
when the user evaluates interactions of agents belonging to the Queue.

Table continues…
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Name Description
DP OU Type The option to select a data partitioned OU type. The evaluation form is

available for selection when the user evaluates interactions of agents
belonging to the data partitioned OU type.

For example, Business, Client, Customer, or Line of Business.

Note:

This field is available only if you are using a data partitioned environment.

This field is mandatory.
Organization Units The option to select an organization unit. The evaluation form is available

for selection when the user evaluates interactions of agents belonging to
the selected Organization Unit. The options are:

• OU Type

• Organization Units

Note:

This field is available based on the DP OU Type you select in a data
partitioned environment.

Header Information

Name Description
Field Name The name of the field in the header of the evaluation form.

This field is mandatory.
Control Type The type of control used to display options in the header of the evaluation

form. The options are:

• Text Box

• Radio Button

• Single Select
Options The option to define values for control type. This option is available for the

radio button and single select control types only. The evaluator can select
from the values that you define while evaluating an interaction.

This field is mandatory.
Display Order The option to set the order in which the options should be displayed.
Active The option to mark the header as active and available for selection in the

evaluation form.
Help Text The help text that describes the evaluation form.
Status The status of the header field. The options are:

• Active

• Inactive
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Button Description
Add To add a header section in the evaluation form.
Edit To edit a header section in the evaluation form.
Delete To delete a header section in the evaluation form.

Criteria

Name Description
Section The option to group one or more criteria under a category. However, it is

not mandatory to enter a section while adding a criterion.

For example, you might want to group criteria under sections such as
Compliance, Customer Service, and Overall Service.

Criteria The option to define a criteria that can be used to evaluate an interaction.
You can create a criterion and add child criteria to the parent.

Button Description
Reorder Form To move criteria across or within sections.
Add To add a criterion. For example, you can add a criterion to check if the

agent greets the customer before starting a conversation.
Add Child To add child criteria within a parent criterion. You can add more than one

child criterion to a parent. However, you can add only three levels within
the hierarchy. A parent criterion can have a child and the child criterion can
have another child.

Add Responses To add responses and define scoring options for a criteria. You can add
responses only to the last node in the hierarchy.

Responses

Name Description
Response Set Associate a response set to the criteria. The system will populate the

scoring variables defined for the response set.
Response View the responses or scoring variables defined for the response set you

associate.
Scoring Conditions Define a scoring condition for a response that the evaluator can select

while evaluating an interaction. The option are:

• Not Applicable: Define a score without a bonus or penalty.

• Exclude from Score: Exclude from defining score, bonus, or penalty.

• Bonus Criteria: Define a bonus along with score for a response at the
criteria level.

• Bonus Parent Criteria: Define a bonus along with score for a response
at the parent criteria level.

• Bonus Form: Define a bonus along with score for a response at the form
level.
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Name Description
• Penalty Criteria: Define a penalty along with score for a response at the

criteria level.

• Penalty Parent Criteria: Define a penalty along with score for a
response at the parent criteria level.

• Penalty Form: Define a penalty along with score for a response at the
form level.

Score Enter a score for the response.
Bonus/Penalty Enter the bonus or penalty for the scoring condition you select. The options

are:

• %

• Raw

Note:

Bonus and penalty can be added to individual criteria, sub-criteria, or
overall form.

Comments Mandatory Select to force the evaluator to provide comments to a response. The user
building the form can predefine a set of standard comments and make it
mandatory such that the evaluator must pick one while evaluating the
criterion.

Conditional Branching Define additional questions that must be triggered for a response.
However, scores cannot be associated to the additional questions.

After evaluating the conditional questions, the evaluator may reconsider his
response to the criterion that triggered the conditional branching.

Assign Course/Quiz Assign course or quiz to a response. Depending on the response that is
selected while evaluating, the course or quiz automatically gets assigned to
the employee.

Comments

Name Description
Comments Add comments to a criterion. Comments help evaluators to flag important

information or common problems in agent performance against a
response. For example, assume there is a criteria for listening. You can
add a comment Agent interrupted customer if this is a common
problem.

Evaluators can either select from a pre defined list of comments available
or enter comments manually.

Description Add a description to a comment. The user who creates the comment can
use this option to provide reasons for adding a comment.

Default Mark a particular comment as default. The defalut comment gets
associated against the criteria by default.

Active Make a comment active so that they become available while evaluating an
interaction.
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Weightages

Name Description
Scoring Options Define the scoring mechanism. The options are:

• Non Weighted: If you select nonweighted, the scores achieved at the
child criteria level rolls up to the parent criteria. The overall score is a
sum of scores achieved against all the criteria.

• Weighted: If you select the weighted option, you must define weights for
every criteria. Weights defined at every criteria node (parent or child)
must sum up to 100. The score achieved at the criteria will be a product
of the raw score and the weight.

Formula Define the arithmetic formula to calculate the overall score.

Preview

Name Description
Definition Preview the evaluation form definition before publishing the form.
Header Information Preview the header information before publishing the form.
Criteria Preview the criteria along with the responses before publishing the form.
Weightages Preview the weights defined for all the criteria before publishing the form.
Test Form To validate form creation completion.

Button Description
Save as Draft Save the evaluation form in a draft state.

Viewing evaluation forms
About this task
Use the Forms page to view the list of evaluation forms that are Active or saved as Draft.

You can view information such as the user who created the evaluation form, the version of the
evaluation form, the scoring pattern and the department and organization unit associated to the
evaluation form.

To filter evaluation forms, use the sort and filter options in the list.

Procedure
1. Click Evaluate > Setup > Form

The system displays the list of Evaluation Forms.

2. To filter evaluation forms, click the Filter (  ) icon on the field based on which you want to
filter.

3. Use the Pagination controls to navigate through the list. You can choose the number of
records that you want to view on each page.
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4. To view the version history of an evaluation form, click the version number in the Version
column.

The system displays the version history of the Evaluation Form in a new window.

5. To view the details of an evaluation form, click the View ( ) icon in the specific row.

6. To edit an evaluation form, click Edit.

The system allows you to edit an evaluation form that has no evaluations performed using
the form. If there are evaluations done using an evaluation form, you can edit the form but
the system creates another version and saves the form in draft mode. You have to publish
the revised form to make it active.

7. To delete an evaluation form, click Delete.

You cannot delete an Evaluation Form if there are any current evaluations based on the
form.

Viewing evaluation forms field descriptions
Name Description
Form The name of the evaluation form.
Created By The name of the employee who creates and owns the evaluation form.
OU(s) The organization unit associated with the evaluation form. The evaluation

form is available to evaluate employees belonging to the associated
organization unit.

Department The department associated with the evaluation form. The evaluation form
is available to evaluate employees belonging to the associated
organization unit.

Scoring Pattern The scoring pattern used for evaluating interactions. The options are:

• Weighted

• Non Weighted
Status The field to indicate whether the Evaluation Form is active and available

during evaluations. The options are:

• Active

• Inactive

• Draft
Default The field to indicate if the evaluation form is set as the default. The options

are:

• Yes

• No
Version The number to indicate the different versions of the evaluation form that is

already published.
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Version

Name Description
Form The name of the evaluation form.
Created By The name of the employee who owns the evaluation form.
Created Date The date on which the employee created the evaluation form.
Updated By The name of the employee who updated the evaluation form.
Updated Date The date on which the evaluation form was updated.
Version The version number of the evaluation form.

Button Description
Duplicate Form To create a copy of the form. You can clone an evaluation form and reuse

the same with minor changes that meet your requirements.

Evaluation Types
As a Supervisor, Reviewer, or a QA specialist, before performing evaluations on interactions, you
might want to perform a test or a mock evaluation. Avaya Workforce Optimization Select gives you
the flexibility to create Evaluation Types to meet such specific requirements. You can create an
Evaluation Type to perform evaluations for either testing or training purposes. You can use the
Evaluation Type feature as a platform to train new hires within your organization.

Typically, interactions assigned through Evaluation Plan, Calibration, or Flagged interactions
automatically default to the Normal evaluation type and cannot be edited. For such evaluations, the
system calculates the agent’s performance based on the ratings and scores given by the evaluator.
However, for the evaluation types you create, you have the option to specify whether or not you
wish to include scores in evaluations. For example, you might want to create a training, mock, or
adhoc evaluation type to train Evaluators. In such cases, you need not include scores to be
considered in reports and notifications.

Viewing Evaluation Types
About this task
Use the Evaluation Type page to view the list of evaluation types that you have created.

In the list, you can view the details of whether an Evaluation Type is used in an evaluation form and
in evaluations for scoring interactions.

To filter evaluation types, use the sort and filter options in the list.

Procedure
1. Click Evaluate > Setup > Evaluation Type.

The system displays the list of Evaluation Types.

2. To filter the evaluation types, click the Filter ( ) icon in the column by which you want to
filter.
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3. To edit an evaluation type, click the > icon in the desired row.

4. To delete an evaluation type, click Delete.

By default, the system displays NormalEvaluation Type. You cannot edit or delete
NormalEvaluation Type.

You cannot edit or delete an Evaluation Type if there are evaluations performed using that
evaluation type.

.

Viewing Evaluation Types field descriptions
Name Description
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.

Note:

You cannot inactivate, edit or delete the default evaluation type
named Normal.

Include in Score The field that indicates that scores will be included for evaluations
performed using the evaluation type.

Evaluations Performed The field used to identify whether the Evaluation Type is used in any
evaluations. The options are:

• Yes

• No
Status The status of the Evaluation Type. The options are:

• Active

• Inactive
Description The description of the type of evaluation.

Icon Name Description
Add To add a new Evaluation Type.

Adding an Evaluation Type
Procedure

1. Click Evaluate > Setup > Evaluation Type.

The system displays the list of Evaluation Types.

2. On the Evaluation Type page, click Add.

3. On the Add Evaluation Type page, enter the appropriate details.
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4. Click one of the following options:

• Save & Add Another: To save the Evaluation Type that you created and add another
type.

• Save & Close: To save the Evaluation Type that you created.

Evaluation Type field descriptions
Name Description
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.
Description The description of the type of evaluation.
Evaluation Type Category The option to select the Evaluation Type for scoring interactions. The

options are:

• Include in Score: Selecting this option has the following impacts:

- The system measures agent performance based on the scores rated
by the evaluator.

- You can generate evaluation specific reports.

- You can build an evaluation form such that courses or quizzes are
assigned to an agent based on the Evaluation score.

- You cannot edit this option if there are evaluations performed using this
evaluation type.

• Exclude from Score: Selecting this option has the following impacts:

- The system will not calculate agent performance based on the scores
rated by the evaluator.

- You cannot generate evaluation specific reports.

- Course and quiz assignments to agents will be ignored.

- Agents will not be able to raise an appeal against evaluations that are
excluded from scores.

- Evaluators can calibrate an evaluation even if the evaluation type is
excluded from scores.

- You can delete an evaluation type even if there are evaluations
performed using this evaluation type. The evaluations performed using
this evaluation type will also be deleted.

- You cannot edit this option if there are evaluations performed using this
evaluation type.

- The evaluator evaluating an interaction that is excluded from scores
will be prompted with a message.

Table continues…
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Name Description
Active The option to select the Evaluation Type as active and available when

evaluating interactions.

• Active: Makes the evaluation type available for selection while
evaluating an interaction.

• Inactive: Deactivates an evaluation type. You cannot deactivate the
Normal evaluation type that is active by default. You cannot perform
evaluations against an evaluation type that is inactive. If there are
evaluations tied to an evaluation type prior to deactivating it, you can
continue to view such evaluations.

You can change the status of the evaluation types you create. You will be
prompted with a message if you change the status of an evaluation type
that has evaluations associated.

Appeals workflow
The appeals workflow is a mechanism that you can use to automate the appeals process. Using the
appeals workflow, you can define who can appeal, who can review, who can approve, who can
escalate, and who can finally approve.

Every appeal raised moves through specific workflow states before it is finally approved by the Final
Approver who has the permissions to finally approve the appeal.

The permissions in the appeals workflow is defined at the role level. The Reviewer can be the
supervisor who provides feedback on the appeal, while the Approver is the Manager who reviews
and approves the appeal.

For more information on the appeals process, see Appeals on page 97.

Note:

You can create an appeals workflow for each data partitioned OU.

The following table describes the appeal workflow roles and permissions that are assigned based on
role:

Appeal workflow permissions

Appeal Process Role Allowed Actions
Creator Select one or more roles as the creator. Employees

belonging to the role and who have access to the
data partitioned organization unit for which the
appeals workflow is created can raise an appeal.

Reviewer Review, Accept, Draw, and Decline

Select only one role as the reviewer. However, you
can add multiple named users or employees outside
of the role hierarchy to review an appeal. Named

Table continues…
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Appeal Process Role Allowed Actions
users comprise of employees who belong to the data
partitioned organization unit for which the appeals
workflow is created. Agents will not be part of the
named users list.

The reviewer provides an input to the approver who
can consider or ignore the input.

Approver Accept, Draw, and Decline.

Select either a role or multiple named users as the
approver. Employees belonging to the role and who
have access to the data partitioned organization unit
for which the appeals workflow is created can
approve or reject an appeal. The approver is usually
the original evaluator or the roles above in the
hierarchy of the evaluator.

Final Approver Final Accept, Final Draw, and Final Decline.

Select either a role or multiple named users as the
final approver. Employees belonging to the role and
who have access to the data partitioned organization
unit for which the appeals workflow is created can do
a final approve or a final reject.

Viewing appeals workflow
About this task
Use the Appeal Workflow screen to view the roles and users defined in the workflow.

Procedure
Click Evaluate > Setup > Appeals Workflow.

The system displays the Appeals Workflow page.

Viewing appeals workflow field descriptions
Name Description
Workflow Name The name of the appeal workflow.
Creator The name of the employee who has raised the appeal.
Reviewer The name of the supervisor or manager who reviews the appeal.
Final Approver The name of the employee who approves or rejects the appeal.
Status The status of the appeal. The options are:

• Active

• Inactive
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Defining an appeals workflow
Procedure

1. Click Evaluate > Setup > Appeals Workflow.

The system displays the Appeals Workflow page.

2. Select the DP OU Type for which you want to create the appeals workflow.

You can create a separate workflow for each data partitioned OU.

3. In Appeal Duration, select the number of days by which the appeals process can be
completed.

However, the system allows the appeal to be completed post the due date too.

Note:

Employees cannot raise fresh appeals against an evaluation when there is an appeal
already in progress.

4. To set the appeal workflow in active status, select Active.

5. In Appeal Process Role, view the appeal roles that are available in the workflow.

6. In Allowed Actions, view the permissions assigned for the roles in appeals process.

7. Select Roles and named users to assign users to the appeal process roles such as creator,
reviewer, approver, and final approver.

Note:

The appeals process roles are configured at role level, and not at employee level.

Appeals workflow field description
Name Description
Business [DP OU Type] The name of the data partitioned OU for which you want to define the

appeals workflow.

This field is mandatory.
Appeal Duration (Days) The number of days within which an appeal must to be completed. There

will be notifications sent 48 hours, 24 hours before the due date and on the
due date. However, the system processes the appeal even after the due
date. Appeals do not become inactive after the duration specified.

This field is mandatory.
Active The option to make the workflow open for the appeals process.
Appeal Process Role The role of the users in the appeals process.
Role The role selected to perform the assigned tasks in the appeals process.
Named User The employees selected to perform the assigned tasks in the appeals

process.
Allowed Actions The set of actions defined for the specific role in the appeals process.
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Manage evaluations

Planning evaluation
Evaluation Plans

Using Evaluation Plans, you can track agent performance from recorded interactions. Evaluation
plans provide insight into the performance improvements made in your contact center operations.

Using evaluation plan, you can take advantage of the following features:

• Define target number of evaluations a reviewer needs to perform for an agent.

• Define which interactions to choose to evaluate.

• Distribute evaluation plan automatically to QA agents and reviewers to save time and improve
workflow.

• Define evaluation plans by Queue with the ability to create multiple evaluation plans for a single
Queue.

• Execute the evaluation plan for the selected employees and push calls through the distribution
pool.

• Assign interactions to QA reviewers from the distribution pool.

Evaluation plan checklist
This checklist provides the high-level process for creating and managing an evaluation plan.

No. Task Description Notes

1 Define evaluation plans
to set targets for
reviewers to evaluate
agents and interactions.

See Defining an evaluation
plan on page 72.

2 Identify employees
whose interactions must
be picked as part of the
evaluation plan.

See Selecting employees
for evaluation on
page 72.

3 Define the target number
of interactions to be
picked for each selected
employee.

See Setting employee
targets for evaluation on
page 73.

4 Select a specific set of
interactions for
evaluation.

See Selecting interactions
for evaluation on
page 74.

Table continues…
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No. Task Description Notes

5 Assign interactions to
reviewers and evaluators
for scoring.

See Assigning interactions
for evaluation on
page 74.

6 Review and publish the
evaluation plan.

See Reviewing and
publishing an evaluation
plan on page 75.

7 Schedule to execute the
evaluation plan so that
the interactions get
assigned as tasks to the
evaluator.

See Scheduling evaluation
plans on page 79.

Defining an evaluation plan
Procedure

1. Click Evaluate > Management > Plans.

2. Click Create A Plan.

3. Enter a name and description for the plan.

4. In Target Period, select the option to define the target period. The options are:

• Weekly

• Monthly

5. If you are using a data partitioned environment, select the DP OU Type, for example, Client
for whom you want to create the evaluation plan.

6. In Week Begins From, select the start day of the work week.

Note:

By default, the administrator sets the start day of the week. You can change the day to
reflect your work week.

7. To publish the evaluation plan, select Active.

After you publish the plan, you can change the status to Inactive if you do not want to run
any evaluations based on the evaluation plan.

Next steps
Select employees whose interactions are picked as part of the evaluation plan.

Selecting employees for evaluation
About this task
Employee selection refers to selection of employees whose interactions must be picked as part of
the plan.
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Selection criteria can be the organizational unit, site, departments, groups, role, reporting to
hierarchy, employee name, tenure of the employee, and custom fields.

Procedure
1. Click the Employee Section tab.

2. In the Employee Filter section, specify the search criteria to filter employees.

a. In Field, select the fields by which you want to filter employees to assign to the plan.

b. In Operator, select the operator for the filter.

c. In Value, enter the value that the records must match.

d. To add multiple filters, click the Add Field (  ) icon.

e. Click Apply Filter.

The system displays the list of employees that match the search criteria in the
Employee List tab.

3. In the Employee List section, select the employees you want to be evaluated under the
evaluation plan.

An employee who is no longer with the organization is not included in the evaluation plan.

Next steps
Define the evaluation plan target.

Setting employee targets
About this task
Use this procedure to specify the target number of interactions that must be picked and assigned for
each of the employees selected.

You can perform the following tasks:

• Specify the interaction distribution to be random or specific. If the interaction distribution is
specific, depending on the target period you define for the plan, you can further specify the
interaction distribution.

• Define the interaction distribution for a given day of the week, if the target period is weekly. The
distribution across the week must not exceed the target.

• Define the interaction distribution for a week of the month, if the target period is monthly. The
distribution across the month must not exceed the target.

• Force the system to meet the distribution target. The system will try to check for interactions
from previous days of the week or weeks of a month to meet the distribution target.

Procedure
1. In Employee, view the total number of employees selected for evaluation.

2. In Target, specify the number of interactions that the plan must assign on a weekly or
monthly basis.
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3. Select the method of sampling interactions for evaluation. Choose one of the following
options:

• Random : To randomly select interactions for evaluation.
• Specific : To select a specific number of interactions on a week day in case of a weekly

plan or on a week in case of a monthly plan.

4. Select the following options for specific distribution:

a. In Distribution, select the week day or the week in a month.
b. In Must meet distribution target, you can specify if the weekly or monthly distribution

target must be met at any cost or not.

Next steps
Select interactions for evaluation.

Defining the interaction selection criteria
Procedure
In the Interaction Selection tab, specify the search criteria to filter interactions to be evaluated.

a. In Field, select the fields by which you want to filter interactions to assign to the plan.
b. In Operator, select the operator for the filter.
c. In Value, enter the value that the records must match.
d. To add multiple filters, click the Add Field ( ) icon.

Next steps
Assign interactions to be evaluated.

Assigning interactions for evaluation
Procedure

1. In the Assignment tab, select the default form to be associated with the evaluation plan.

2. In Assignments, select the option to assign interactions to reviewers or send the
interactions to the Distribution Pool.

3. Select To Reviewers to view a list of eligible reviewers who have access to the interactions
and can evaluate the interactions.

The system displays the reviewers, assignments under the current plan, and total
assignments across all plans.

4. From the list, select the reviewers that you want to assign to evaluate the interactions.

The system displays the interactions in the Evaluate > Evaluations > My Assignment page
of reviewers.

5. To add interactions to the distribution pool, select To Distribution Pool.

Next steps
Preview and publish an evaluation plan.
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Reviewing and publishing an evaluation plan
Procedure

1. Complete the mandatory steps in the Definition, Employee Selection, Target, Interaction
Selection, and Assignment tabs.

2. On the Preview tab, view the details of the evaluation plan.

3. Click Publish to publish the evaluation plan. The plan starts running from the moment you
publish the evaluation plan. Depending on the plan definition, the system looks for
interactions and starts assigning interactions.

The system displays the evaluation plan in the list on the View Plans page with Active status.

4. Click Publish & Schedule to set the plan for execution. From the scheduled data and time,
the plan runs everyday and assigns tasks to the selected reviewers.

The system assigns interactions to reviewers and evaluators for evaluation on the scheduled
date and time.

Note:

The evaluation plans run according to the time zone configured by the administrator in
Administration > Settings > General Settings.

Evaluation Plan field descriptions
Definition

Name Description
Name The name of the evaluation plan.
Description The description of the evaluation plan.
Target Period The frequency at which interactions are assigned.

The options are:

• Weekly

• Monthly
DP OU Type The organization units that are tied to the data

partitioned OU type.

For example, Business, Client, Customer, or Line
of Business.

Note:

This field is available in a data partitioned
environment based on the settings configured by the
system administrator.

Week begins from The start of the work week. The options are:

• Monday to Sunday
Table continues…
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Name Description
• Sunday to Saturday

Note:

This options you see depend on the settings
configured by your system administrator.

Active The status of the evaluation plan.

Note:

This option is available after you save the plan as
Draft.

Employee Selection

Name Description
Employee Filter The field to filter and search employees to add to the

evaluation plan.

You must specify the following before you apply
filters:

• Field: The fields used to filter the search.

• Operator: The operator used in the search criteria.

• Value: The value to match in the search.
Employee List The list that displays the search results for

employees.

You can select one or more employees from the list.

Employee search

Name Description
Field The fields for searching employees. The options are:

• Organizational Units

• Site

• Group

• Department

• Role

• Employee

• Reporting To

• Tenure
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Target

Name Description
Employee The total number of employees selected for

evaluation as part of the plan.
Target The target number of interactions that are assigned

from the selected plan.
Distribution The method of sampling interactions for evaluation.

The options are:

• Random: Interactions are picked randomly when
the plan is run during the defined period.

• Specific: Interactions are assigned based on the
distribution target selected during the defined
period.

Distribution On The number of interactions to be evaluated during
the work week or month.

Meet Distribution Target The option to specify if the weekly or monthly
distribution target must be met at any cost or not.
The options are:

• Yes: Forces the system to meet the distribution
target. For example, assume you define the target
as 5 interactions for each employee, a weekly
distribution of 2 interactions on Monday and 3 on
Thursday, and the option to meet distribution target
as Yes. The system picks 2 interactions for the
selected employees on Monday. If there are no
interactions for a particular employee on Monday,
the system checks for interactions from the
previous days of the week and tries to meet the
distribution target. Similarly, for a monthly
distribution, the system checks for interactions
from the previous weeks of the month and tries to
meet the distribution target. If the distribution target
is not met due to unavailability of interactions, the
system will not roll over the target to the next week
or month.

• No: Tries to meet the distribution target. If the
distribution target is not met, the system continues
to move ahead. The system will not check for
interactions from previous days of a week or weeks
of a month.

Supervisor The supervisor to whom the employee reports.
Department The department to which the employee belongs.
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Interaction Selection

Name Description
Field The fields used to filter the interactions. The options

are:

• Calling Party

• Called Party

• Channel

• Commented

• DNIS

• Duration

• Hold Duration

• No of Holds

• No of Transfers

• Queue

• Screen Captures

• Tagged

• Variables 1 to 10
Operator The operator used in the search criteria.
Value The value to match in the search.

Assignment

Name Description
Default Form The evaluation form that is set as the default for the

evaluation plan.
Assignments The total number of calls assigned to each reviewer.
Reviewer The employees who have access to the interactions

of the selected agents and who possess evaluation
permission.

Note:

Only supervisors or managers of the employees
selected to be evaluated are listed.

Number of interactions equally assigned from
this plan

The number of interactions the system equally
assigns to reviewers based on the target you specify
for the evaluation plan.

Total assignments across plans The number of interactions evaluated across
different plans during the last 30 days.
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Preview

Name Description
Definition Defines the plan and sets the visibility.
Employee Selection Selects specific agents for evaluation.
Target Defines the targets for agents.
Interaction Selection Selects the interactions to be evaluated.
Assignment Assigns interactions to reviewers or push to the

distribution pool for evaluation.

Scheduling an evaluation plan
About this task
Use this procedure to schedule the evaluation plan to run on a scheduled date and time. The plan
runs everyday at the specified time from the effective date and assigns interactions to the selected
reviewers.

Procedure
1. Select the saved evaluation plan and navigate to the Preview tab.

2. Click Publish & Schedule to set the plan for execution.

3. Select Run on a Schedule to enable the scheduler.

4. Select or enter the option to schedule the evaluation plan on specific date and time. The
options are:

• Effective Date

• Run At

By default, the date is set to current date. You can schedule the plan to run on any date
beyond the current date.

Note:

The scheduled evaluation plans run according to the time zone configured by the
administrator in Administration > Settings > General Settings.

5. Click Save to save the evaluation plan.

Viewing evaluation plans
About this task
Use this procedure to view the list of evaluation plans along with details like the plan owner, status,
and employees covered.

You can also view the details of the last run date and period during which the plan is run.
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From the Plans page, you can perform the following actions:

• Create an evaluation plan.
• Delete an evaluation plan.
• Run a plan instantaneously. You can select the Run now option to run a plan at that moment.

You can also select the Run option to run a plan from a previous date to the current date. The
system picks and assigns interactions to reviewers based on the date range you specify. In
both the cases, the assignment happens just once.

Procedure
1. Click Evaluate > Management > Plans.

The system displays the list of saved and published evaluation plans.

2. To filter evaluation plans, click the Filter (  ) icon on the field based on which you want to
filter.

3. Use the Pagination controls to navigate through the list. You can choose the number of
records you want to view on each page.

4. To edit an evaluation plan, click the > icon on the desired row.

The system displays the evaluation plan in Edit mode allowing you to make changes to the
plan.

5. To delete an evaluation plan, select the evaluation plan you choose to delete, and click
Delete.

6. To run a plan, select the evaluation plan with Active status, and click Run Plan.

You can run the plan on the current date or for a specified period.

Viewing evaluation plans field descriptions
Name Description
Plan Name The name of the evaluation plan.
Period The period during which the interactions of agents are evaluated.
Created By The name of the employee who owns the evaluation plan.
Employee Coverage The total number of employees that are selected for evaluation as part of

the plan.
Target The total number of interactions that are to be evaluated as part of the

plan.
Assigned The total number of interactions that are assigned to reviewers for

evaluation as part of the plan.
Run At The date and time when the evaluation plan is scheduled to run.
Last Run The date on which the evaluation plan was last run.

Table continues…
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Name Description
Last Run By The name of the employee by whom the evaluation plan was last run.
Status The status of the evaluation plan.

• Active

• Inactive

Viewing Employee Coverage
About this task
Use the Employee Coverage page to view the list of employees covered under different evaluation
plans.

The list displays the quality scores, average handle time, number of evaluations covered, and the
projected coverage in the next 30 days for all the employees that you have access to.

To filter evaluations, use Views and the sort and filter options in the list.

Procedure
1. Click Evaluate > Management > Employee Coverage.

2. Click View to view a list of employees covered across all plans.

3.
To filter the evaluations, click the Filter (  ) icon in the column by which you want to filter.

4. Use the Pagination controls to navigate through the list. You can specify the number of
records that you want to view on each page.

Viewing Employee Coverage field descriptions
Name Description
Employee The name of the employee who is evaluated.
Tenure (Weeks) The tenure of the employee in the organization, in weeks.
Quality Score The score received by the employee during evaluation.
Avg Handle Time The average duration from the start of the interaction till the end including

the hold time.
Past Coverage The total number of interactions assigned for evaluations in the last 30

days.

The interactions might have been assigned through different plans,
distribution pool or ad hoc evaluations.

Projected Coverage The total number of evaluations targeted for the employee across different
evaluation plans.

Table continues…
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Name Description
The value is the total number of interactions expected to be completed
within the next 30 days.

Viewing QA Coverage
About this task
Use the QA Coverage page to view the list of all reviewers who have their evaluations tasks either in
pending or draft state. You can reassign tasks to another reviewer.

To filter evaluations, use Views and the sort and filter options in the list.

Procedure
1. Click Evaluate > Management > QA Coverage.

The system displays a list of evaluations covered for various employees.

2. To filter the evaluations, click the Filter icon in the column by which you want to filter.

3. Use the Pagination controls to navigate through the list. You can specify the number of
records that you want to view on each page.

4. Select the evaluations that you want to reassign to other reviewers from the Re-assign To
drop-down list, and click Assign.

The system displays the evaluation task under the My Assignment screen for the assigned
employee.

A notification is sent to the assigned employee for evaluating the interaction.

Viewing QA Coverage field descriptions
Name Description
Reviewer The name of supervisor or manager who evaluates the interactions.
Employee The name of the employee who is evaluated.
Supervisor The name of the supervisor or manager to whom the employee reports.
Transaction Date The date on which the interaction is recorded.
Transaction Type The type of channel on which the interaction is delivered. The options are:
Queue The queue that the interaction is associated with.
Origin The field to indicate the origin of the evaluation. The options are:
Screens The field to indicate if the interaction has screens captures. The options

are:
Interaction ID The unique ID of the interaction.
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Name Description
Status The field to indicate the status of the evaluation. The options are:

• New

• Draft

Assigning evaluations from Distribution Pool
About this task
Use this procedure to view and select interactions that you want to assign to reviewers for
evaluation.

To filter interactions, use Views and the sort and filter options in the list.

The interactions in the Distribution Pool are available when:

• A Supervisor flags interactions for QA while monitoring live interactions.
• An evaluator declines evaluations in the My Assignment page.

From the interaction list, you can select and evaluate an interaction that is not assigned to you.

Procedure
1. Click Evaluate > Management > Distribution Pool.

The system displays the list of interactions available in Distribution Pool.

2. Select the evaluations that you want to assign to other reviewers from the list, and click
Assign.

The system displays the evaluation task in the My Assignment screen for the assigned
employee.

A notification is sent to the assigned employee for evaluating the interaction.

3. To assign an interaction to yourself , click Add to My Assignments.

4. To delete an interaction from Distribution Pool, select the interaction and click Delete.

You can delete an interaction only if you have the relevant privileges.

Distribution Pool field descriptions
Name Description
Plan Name The name of the plan that is used for evaluating the interactions.
Interaction ID The unique ID of the interaction.
Interaction Date The date on which the interaction takes place.
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Name Description
Supervisor The name of the supervisor or manager to whom the employee reports.
Origin The field to indicate the origin of the evaluation. The options are:

• Plan

• Interaction Playback

• Live Monitoring
Duration The duration of the interaction in the hh:mm:ss format.
Screens The field to indicate if the interaction has screens captures. The options

are:

Evaluations

Evaluate Interactions
Evaluating an interaction

About this task
When you evaluate an interaction, you can score the interaction on each evaluation criteria and sub-
criteria. You can view snippet comments, employee profile and interaction details, and each
segment of the interaction.

You can evaluate an interaction in any of the following ways:

• Evaluate when playing back audio recording and screen captures from a previously recorded
interaction.

• Evaluate an employee’s performance in real time, while listening to the employee while they
are attending to the interaction.

• Evaluate interactions from your My Assignment page.

Procedure
1. To evaluate a recorded interaction:

a. Click Interactions > Playback.

b. On the Playback page, click the Play ( ) icon next to the recorded interaction that you
want to evaluate.

c. On the Call Details page, click Evaluate Now.

2. To evaluate a live interaction:

a. Click Live Monitoring > Monitor.
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b. On the Monitor page, click the Play (  ) icon next to the live interaction that you want
to evaluate.

c. On the Call Details page, click Evaluate Now.

3. To evaluate interactions from My Assignment:

a. Click Evaluate > Evaluations > My Assignment.

b. Click the View ( ) icon in the specific row.

4. On the Call Details page, click the Evaluation tab.

The system displays the interaction in the Recorder pane.

The there is no evaluation form associated for evaluation, the section below the Recorder
pane appears blank.

5. From Form drop-down list, select any active evaluation form.

6. From Evaluation Type drop-down list, select any active evaluation type.

The system displays the evaluation criteria for the form.

7. For each evaluation criteria, select a response and score the interaction.

8. To view previous evaluations on the interaction during evaluation, click the Previous
Evaluations tab.

9. To add comments to the interaction during evaluation, click the Comments/Tags tab, and
enter comments and tags.

10. To view the interaction details during evaluation, click the Call Details tab.

11. To view the interaction segment details, click the Segmentation tab.

Adding evaluation comments
About this task
Evaluators, managers, and supervisors can add comments to an evaluation either while they are
scoring it, or after complete scoring the form. Agents can add comments to an evaluation after the
evaluation is scored.

There are two types of comments that you can add when evaluating an interaction.

• Form comments: General comments that apply to the entire evaluation form.
• Evaluation criteria comments: Comments that apply to a specific criteria that you are

evaluating.
• Snippet comments: Comments that you can add to a particular segment of the interaction. You

can specify the start time, end time, and severity for a snippet comment.

Procedure
1. Click the Comments (  ) icon to the right of the evaluation criteria, and enter comments.

The system displays a text area to enter comments. You can see the comments after you
save the evaluation form.
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2. In General Comments , enter overall comments for the evaluation.

Note:

You can also add comments in the Snippet Comments and Comments/Tags tab for live
and recorded interactions.

Evaluation score calculation
The evaluator or reviewer scores the interaction by selecting appropriate responses against criteria.
The evaluator scores the interaction by responding to the evaluation questions in the form and
analyzing how the employees handle the interaction with customers.

The scoring mechanism can be weighted or nonweighted and the final score is awarded differently
for each scoring mechanism.

The overall score is calculated accordingly:

• For nonweighted evaluations, the scores achieved at the child criteria level roll up to the parent
criteria. The overall score is a sum of all scores achieved for the criteria.

• For weighted evaluations, weights are defined for every parent criteria, criteria and child
criteria. The weights must sum up to 100.

The score achieved at the criteria is a product of the raw score and the weight.
• The bonus or penalty is calculated at the parent or child criteria level, or at the overall

evaluation form level.

If the evaluation form has an associated bonus or penalty as a percentage of the criteria score,
the overall score is calculated accordingly.

Example

Consider the following evaluation form with criteria and sub-criteria:

Section A: Greeting

• C1: Did the agent or employee greet the customer properly?
• C2: Did the agent or employee identify themselves with the customer?
• C3: Did the agent or employee mention that the interaction is being recorded?

Section B: Customer Service

• C1: Did the agent or employee verify the information provided by the customer?
• C2: Did the agent or employee rush or talk over the customer voice?
• C3: Did the agent or employee show empathy towards the customer?
• C7: How was the overall performance of the employee?

A bonus and penalty is given for evaluation responses 1, 2, and 3 at the parent criteria level. For
response 1 and 3 from the evaluator, a bonus of 2% and 3 points is awarded. For response 2, a
penalty of 1% is awarded.

The evaluation form is a weighted form, with the weightage given to criteria C4 to C7 towards the
overall scores given as 20, 10, 10, and 50.
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The employee receives scores 3, 5, 2, 8, 5, 5, 10 for the evaluation criteria C1 to C7 based on the
evaluator scoring the interaction.

The total score is displayed after the evaluator scores each question in the form.

The overall scores are calculated as follows:

Criteria score with bonus and penalty

For bonus and penalty given as percentage, the score is calculated as:

Criteria score = Bonus or penatly percentage/100 plus or minus the actual score that is awarded.

For bonus and penalty given as raw score, the score is calculated as:

Criteria score = Bonus or penatly raw score plus or minus the actual score that is awarded.

• Bonus score for criteria C1 = 2 percent of 3 = 0.06.

Criteria C1 score = 3 + 0.06 = 3.06
• Penalty score for criteria C2 = 1 percent of 5 = 0.05

Criteria C2 score = 5 - 0.05 = 4.95
• Bonus score for criteria C3 = 1 points.

Criteria C3 score = 2 + 1 = 3

Criteria score based on weightage

For criteria C4 to C7, the score is calculated as weighted score x the actual score that is awarded.

Weightage score = weightage percentage/100

Criteria score = weighted percentage/100 x actual score that is awarded.

The scores for criteria are:

• Criteria C4 score = 8 x 0.2 = 1.6
• Criteria C5 score = 5 x 0.1 = 0.5
• Criteria C6 score = 5 x 0.1 = 0.5
• Criteria C7 score = 10 x 0.5 = 5

The overall form score is the total of all criteria (parent) and sub-criteria (child criteria) scores in
each section of the form. 3.06 + 4.95 + 3 + 1.6 + 0.5 + 0.5 + 5 = 18.61 points.

The overall score is rounded off to 19 points.

Evaluation details field descriptions
Evaluation

Name Description
Form The form based on which the evaluation is performed.
Evaluation Type The type of evaluation. For example, Training, Ad-hoc, Mock, or Normal.
General Comments The comments that are entered by the evaluator during evaluation.
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Name Description
Section The section that groups the parent criteria and sub-criteria that must be

evaluated.
Criteria The parent criteria and sub-criteria that must be evaluated.

Note:

You can successfully save the evaluation only when you complete
evaluating all the criteria.

Previous Evaluations

Name Description
Form The form based on which the evaluation is performed.
Reviewed By The name of the supervisor or manager who evaluated the interaction.
Evaluation Type The type of evaluation. For example, Training, Ad-hoc, Mock, or Normal.
Score The score that is received by the employee during evaluation of the

interaction.
Evaluation Date The date on which the evaluation is performed.
Course/Quiz The course or quiz that is assigned to the employee based on the

evaluation scores.

Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.

Tags

Name Description
Date The date on which the tag is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
From The name of the employee who adds the tag.
Never delete the call The tag used to specify that the interaction should never be deleted.
Need training The tag used to specify that the employee attending to the interaction

requires further training.
Do not allow download The tag used to specify that the interaction cannot be downloaded.
Do not allow download &
email

The tag used to specify that the interaction cannot be downloaded or sent
by email.
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Call details

Name Description
Interaction ID The unique ID of the interaction.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
Duration The duration of the interaction in the hh:mm:ss format.
Employee Code The employee code of the agent who attended to the interaction.
Employee Name The name of the employee who attended to the interaction.
Extension To search by the extension number of the called party.
Location The name of the site the employee belongs to.
Group Belongs To The name of the group that the employee belongs to.
Supervisor The name of the supervisor or manager to whom the employee reports.
Channel The type of channel on which the interaction is delivered. The options are:
Screen The field to indicate if the interaction has screens captured. The options

are:

• Yes

• No
Number of Holds The number of times that the employee put the interaction on hold.
Hold Duration The total duration for which the employee put the interaction on hold in the

hh:mm:ss format.
Number of Transfers The number of times that the employee transferred the interaction.

Emailing an evaluation
About this task
You can email an evaluation if you want other users to view or give feedback on the evaluation. The
evaluation appears as a link, and the user must log on to the application to access the evaluation.

Procedure
1. Click Evaluate > Evaluations > View Evaluations.

2. Click the View ( ) icon in the specific row.

The system displays the Call Details page.

3. In the Evaluations tab, click the Email ( ) icon.

4. Enter the message, recipient details, and click Send.

Printing an evaluation
About this task
You can print evaluations that you have access to.
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Procedure
1. Click Evaluate > Evaluations > View Evaluations.

2. To view the details of an evaluation, click the View ( ) icon in the desired row.

The system displays the Call Details page.

3. In the Previous Evaluations tab, view the details of evaluations by other users for the same
interaction.

4. In the Evaluations tab, view the details of the current evaluation before printing.

5. Click the Print ( ) icon.

The system prints the evaluation criteria, responses, and scores given to the interaction.

Viewing My Assignment
About this task
Use the My Assignment screen to view the interactions that are assigned to you for evaluation.

You can view the evaluations already performed and search for interactions that you want to add to
My Assignment. The list displays all the evaluations that are New or saved as Draft. To filter
evaluation assignments, use the sort and filter options in the list.

Choose the interaction that you want to evaluate or decline the interactions that are assigned to you.
The evaluation that a user declines moves to the distribution pool and will be available for
assignment. After you complete evaluating the interaction, the status of the evaluation assignment is
displayed as Completed.

Procedure
1. Click Evaluate > Evaluations > My Assignment.

The system displays a list of evaluations that are assigned to you.

2. To filter the evaluations, click the Filter (  ) icon in the column by which you want to filter.

3. Use the Pagination controls to navigate through the list. You can choose the number of
records that you want to view on each page.

4. Perform the following actions:

a. To view the details of an interaction to evaluate, click on the View ( ) icon in the
desired row.

b. To view the interaction details and previous evaluations on the interaction, click the Call
Details tab.

c. To begin evaluation, on the Evaluate tab, select an evaluation form, evaluation type,
responses for the criteria.

d. To add comments or tag to the interaction, click the Comments/Tags tab.
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5. To decline an evaluation assigned to you, select the interaction from the list and click
Decline Selected Evaluations.

The evaluation moves to the Distribution Pool and will be available for assignment.

Viewing My Assignment field descriptions
Name Description
Employee The name of employee whose interaction is evaluated.
Supervisor The name of the supervisor or manager to whom the employee reports.
Transaction Date The date on which the interaction is recorded.

• Chat

• Email

• Voice
Transaction Type The type of channel in which the interaction is recorded. The options are:
Queue The queue that the interaction is associated with.
Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.
Screens The field to indicate if the interaction has screens captures. The options

are:
Interaction ID The unique ID of the interaction that is evaluated.
Status The status of the evaluation that is assigned. The options are:

Button Description
Decline Selected
Evaluations

To decline the selected interactions for evaluations.

Viewing evaluations
About this task
Use the View Evaluations page to view the list of evaluations completed by the employees that you
have access to.

To filter evaluations, use Views and the sort and filter options in the list.

You can create a new Evaluation and edit or delete an existing Evaluation if you have adequate
permissions.

Procedure
1. Click Evaluate > Evaluations > View Evaluations.

2. Click View to search for evaluations that match the filter criteria defined in the View.

Evaluations

May 2016 Using Avaya Workforce Optimization Select 91
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


The system displays a list of completed evaluations in the selected View.

3. To view the details of an evaluation, click the View ( ) icon in the specific row.

4. To edit an evaluation, select the interaction and click Edit.

Depending on your privileges, you can edit the evaluation scores, interaction comments, and
tags for the interaction.

5. To delete an evaluation, select the interaction and click Delete.

Depending on your privileges, you can either delete evaluations assigned to you or all
evaluations.

Viewing evaluations field descriptions
Name Description
Employee The name of employee whose interaction is evaluated.
Supervisor The name of the supervisor or manager to whom the employee reports.
Evaluation Date The date on which the interaction is evaluated.
Transaction Type The type of channel in which the interaction is recorded. The options are:

• Chat

• Email

• Voice
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.
Form The form based on which the evaluation is performed.
Score The score received by the employee during evaluation.
Queue The queue that the interaction is associated with.
Screens The field to indicate if the interaction has screens captures. The options

are:
Interaction ID The unique ID of the interaction that is evaluated.

Button Description
Edit To edit the selected evaluation.
Delete To delete the selected evaluation.

Performing ad hoc evaluations
About this task
Use the Adhoc Evaluations page to search and list the interactions that you want to evaluate.
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From the interaction list, you can select and evaluate an interaction that is not assigned to you.

To filter evaluations, use Views and the sort and filter options in the list.

Procedure
1. Click Evaluate > Evaluations > Ad hoc Evaluations.

2. Select a View to search for evaluations that match the filter criteria defined in the View.

The system displays a list of evaluations under the selected View.

3. To evaluate an interaction, click the View ( ) icon in the specific row.

The system displays the New Evaluation page.

4. To assign an interaction to yourself for evaluation, select an interaction and click Add to My
Assignment.

The Type column in the My Assignment page displays whether the interaction is from Plans
or Ad hoc.

You can evaluate the interaction using any evaluation form available for ad hoc evaluations.

Performing ad hoc evaluations field descriptions
Name Description
Employee The name of employee whose interaction is evaluated.
Reporting To The name of the supervisor or manager to whom the employee reports.
Transaction Date The date on which the interaction is recorded.
Transaction Type The type of channel in which the interaction is recorded. The options are:
Queue The queue that the interaction is associated with.
Screens The field to indicate if the interaction has screens captures. The options

are:
Interaction ID The unique ID of the interaction that is evaluated.

Evaluation History

Name Description
Form The form based on which the evaluation is performed.
Evaluated By The name of the employee who has evaluated the interaction.
Status The status of the evaluation. The options are:
Score The score received by the employee during evaluation.
Evaluation Date The date on which the interaction is evaluated. The date is in the

mm:dd:yyyy format.
Course/Quiz The course or quiz assigned to the employee who is being evaluated.
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Button Description
Add to My Assignments To add the selected evaluation to the My Assignments page.

Calibration

Calibrations
To maintain the quality of interactions with customers, supervisors, and Quality Assurance (QA)
reviewers, you can evaluate agents for their performance at regular intervals. However, since these
evaluations involve a level of subjectivity, consistency becomes a challenge.

The Calibration functionality helps different evaluators assess interactions similarly. It enables you to
measure a single transaction among multiple users, to ensure that all managers and supervisors are
using the evaluation form correctly and applying the quality criteria consistently. Avaya Workforce
Optimization Select provides the user with the flexibility to perform calibrations for non voice
interactions such as email and chat transactions

Viewing calibrations
About this task
Use the Calibration page to view the evaluations that you have calibrated.

You can edit or delete a calibration from the list.

Procedure
1. Click Evaluate > Calibration.

The system displays list of all calibrations that you have created.

2. To edit a calibration, click the View ( ) icon in the desired row.

You can change interactions selected for calibration, reviewers, moderator, evaluation form,
due date, lock on due date, and the option to flag the task as calibration.

3. To delete a calibration, select the interaction that is already calibrated, and click Delete.

A calibration can be deleted, if there are active evaluations or pending tasks associated with
that calibration.
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Viewing calibrations field descriptions
Name Description
Interaction ID The ID of the interaction that is calibrated.
Assigned Date The date on which the calibration was assigned.
Updated On The date on which the calibration status is last updated.
Recommended Form The evaluation form based on which the calibration is performed.
Due Date The date by which the calibration needs to be completed.
Status The status of the calibration. The options are:

• Active

• Completed

• In progress

Calibrating evaluations
About this task
Use this procedure to create and manage calibrations for voice based interactions as well as non-
voice interactions, such as email and chat transactions.

If you have adequate privileges to calibrate an interaction, you can assign the same interaction to
different evaluators. The evaluators can view the calibration tasks and evaluate that interaction.

Once the evaluators complete the evaluation, you can set the final consensus score and standards
for evaluating similar interactions.

Procedure
1. Click Evaluate > Calibration.

2. In the Select Interaction section, select the interactions that you want to assign from
calibration.

3. Filter the interactions you want to assign using Views.

4. In the Select Reviewers section, select the moderators who will evaluate the interaction.

You must select at least one reviewer and one moderator for calibrating the interaction.

5. Select the evaluation form that you want to assign for scoring the interaction.

6. In Due Date, select the date by when the moderators and reviewers must complete the
calibration task.

7. If you do not want evaluators to calibrate post the due date, enable Lock On Due Date
option.

Calibration
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8. If you want the system to display the evaluation as a Calibration, enable Show it as a
Calibration option.

The system displays the evaluation as Calibration in the My Assignment page of the
evaluators.

If the user does not select the option, the evaluation appears in the My Assignment screen
as a task that has come from Evaluation Plan.

Calibration field descriptions
Select Interactions

Name Description
View The option that displays the filters used for the

selected view.
Employee The name of the employee who is evaluated.
Supervisor The name of the supervisor or manager the

employee reports to.
Transfers The name of the employee to whom the interaction

was transferred.
Queue The queue to which the interaction belongs.
Screens The field to indicate whether the recording has

screen capture. The options are:

• Yes

• No
Interaction ID The record ID of the interaction.
Start Time The start time of the interaction.
End Time The end time of the interaction.
Duration The total duration of the interaction.

Select Reviewers

Name Description
Moderator The name of the employee who is assigned as the

moderator for the calibration process.
Reviewer The name of the employees who will evaluate the

interaction as part of the calibration task.
Evaluation Form The form based on which the evaluation is

performed.
Due Date The due by which the calibration needs to be

performed.
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Name Description
Lock On Due Date The date until which the calibration remains active.
Show it as a Calibration The option to mark the evaluation as a calibrated.

Appeals

Appeal summary
The Appeals feature in Avaya Workforce Optimization Select allows an employee with appropriate
permissions to appeal against an evaluation. An employee can raise an appeal from the View
Evaluations screen against each criterion.

The appeals process can be summarized as follows:

• An employee who belongs to the creator role defined in the appeals workflow, can raise an
appeal against an evaluation. It is not necessary that only agent can raise an appeal. Any user
who has access to the data partitioned organization unit of the agent can also raise an appeal.
When a user raises an appeal from the View Evaluations screen, the status of the appeal
appears as New. A notification is sent to users who are assigned the reviewer role in the
appeals workflow once an appeal is raised. Users within the hierarchy of the employee who
has handled the interaction for which appeal has been raised are also notified.

• The next step in the appeals process is to review the appeal. At least one of the employees
defined as the reviewer role in the appeals workflow must review the appeal. Reviewers can
view the list of all the appeals raised on the Appeals page. Reviewers can select options like
Accept, Decline, Draw-score change, Draw-no score change. Post review, the status of the
appeal changes to In Review state. Note that agents only view the appeal status on the
Appeals page. Agents cannot view the reviewer name or the comments and actions that the
reviewer has taken. A notification is sent to the evaluator who evaluated the interaction after
reviewers provide their feedback. The verdict given by the reviewer is only a recommendation
to the approver. The approver is not bound by the verdict of the reviewer.

• Once reviewed, the appeal needs to be approved. Users who belong to the approver role
defined in the appeals workflow can approve or decline an appeal. The approver can select
options like Accept, Decline, Draw-score change, Draw-no score change.

- If the approver accepts all the criteria against which the appeal is raised, the status of the
appeal changes to Approved.

- If the approver declines all the criteria against which the appeal is raised, the status of the
appeal changes to Declined.

- Even if the approver accepts one criteria and marks the others as Decline, Draw - score
change, Draw - no score change, the status of the appeal changes to Partially Approved.
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- Even if the approver selects one criteria as Draw - score change and marks the others as
Decline or Draw - no score change, the status of the appeal changes to Partially Draw -
score change.

- Even if the approver selects one criteria as Draw - no score change and marks the others as
Decline, the status of the appeal changes to Partially Draw - no score change.

• Post approval, the appeals process allows you to escalate. Only the roles above the employee,
whose interaction was appealed, can escalate. The status of the appeal changes to Escalated.
A notification is sent to users who are assigned the final approver role in the appeals workflow
once an appeal is escalated.

• Post approval, decline, or escalation, the appeal moves to the final approve, final decline, or
final draw state. Users who belong to the final approver role defined in the appeals workflow
can change the state of the appeal to final approve, final decline, or final draw. The final
approver can select options like Accept, Decline, Draw-score change, Draw-no score change.

- If the final approver accepts all the criteria against which the appeal is raised, the status of
the appeal changes to Final Approved.

- If the final approver declines all the criteria against which the appeal is raised, the status of
the appeal changes to Final Declined.

- Even if the final approver accepts one criteria and marks the others as Decline, Draw - score
change, Draw - no score change, the status of the appeal changes to Partially Final
Approved.

- Even if the final approver selects one criteria as Draw - score change and marks the others
as Decline or Draw - no score change, the status of the appeal changes to Partial Final
Draw - score change.

- Even if the final approver selects one criteria as Draw - no score change and marks the
others as Decline, the status of the appeal changes to Partial Final Draw - no score change.

• Post approval or decline, a notification is sent to the agent who handled the interaction and the
supevisor.

If the user who raised the appeal is not satisfied with the reevaluation scores and feedback by the
evaluator, the user can reappeal against the evaluation.

For more information on appeal role definitions, see Appeals Workflow on page 68

Processing appeals
About this task
Depending on the role defined in the appeals workflow, you will be able to process appeals from the
Appeals page. Users with the appropriate role can review, accept, decline, draw, and escalate an
appeal request. You can track the status of the appeal from the Appeals page.

For more information, see Appeals on page 97.

Procedure
1. Click Evaluate > Appeals.
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The system displays the list of appeals raised.

2. To filter the list, click the Filter (  ) icon on the field based on which you want to filter.

3. Use the Pagination controls to navigate through the appeal list. You can choose the number
of records you want to view on each page.

4. To delete an appeal, select the appeal from the list, and click Delete.

5. To view the appeal details, click the > icon in the desired row.

6. Enter your comments in the Your Comments text box.

7. Select the Approval Status for the appeal.

8. Click Submitto save the changes.

The appeal status changes and appears on the Appeals page.

Raising an appeal
About this task
Use this procedure to raise an appeal against the evaluation scores by selecting a criteria and
adding comments to the criteria.

Once you raise an appeal, employees who are defined as reviewers in the workflow, get notified.
Only these employees can review and provide comments.

Note:

You can raise an appeal if you have the necessary permission. You can raise multiple appeals
against the same evaluation. However, while an appeal in process, you cannot simultaneously raise
another appeal for the same evaluation.

Procedure
1. Click Evaluate > Evaluations > View Evaluations.

2. In the View Evaluations page, click the > icon in the desired row.

3. Click Appeals in the recorded call pane of the evaluation screen.

The system displays the New Appeal page.

4. Enter your comments in the Your Comments field for the appropriate performance criteria
and click Save.

Notification is sent to the employees who are selected as reviewers in the appeal reviewer
role.
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Appeals field descriptions
Appeals

Name Description
Interaction ID The unique ID of the interaction being evaluated.
Employee The name of the employee whose performance is being evaluated.
Reporting To The name of the supervisor or manager the employee reports to.
Evaluation Date The date on which the evaluation is performed.
Form The evaluation form based on which the evaluation is performed.
Score The score received by the employee during evaluation.
Status The current status of the appeal.

Appeal Details

Name Description
Section The section of the evaluation for which an appeal is raised.
Criteria The evaluation criteria for which an appeal is raised.
Score The score received by the agent for the evaluation criteria.
Agent Comments The comments by the employee who raises the appeal.
Your Comments The comments or feedback you can provide during the review of the

appeal process.
Approval Status The approval status of the appeal that you can select during the review of

the appeal process. The options are:

• Accept: The option that allows the user to modify the scores for the
evaluation.

• Decline

• Escalate

• Draw - score change: The option that allows the user to modify the
scores for the evaluation.

• Draw - no score change

The options you see differ based on your role.

Appeal History

Name Description
Recommendation The name of the reviewer who reviews or evaluates the appeal.
Role The role defined in the appeals workflow who has permissions to review or

finally approve the appeal.
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Name Description
Comment The comments or feedback provided by the reviewers or evaluators during

the review of the appeal.
Recommendation The recommendation provided by the reviewer or evaluator.
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Chapter 6: Managing learning

Learn
Using the Learn module, you can put knowledge in the hands of those who need it, when they need
it the most. Contact centers will have better trained, motivated, and empowered agents, resulting in
improved customer satisfaction, retention, advocacy, and profitability. You can train the agents in
your contact center with courseware and quiz to help improve their efficiency.

The benefits of the Learn module include:

• Provision to upload videos, slide presentations, and other courseware to assign to selected
employees.

• Ability to attach a quiz with randomization of questions for courses.

Viewing course and quiz library
About this task
Use the Library screen to view the list of courses and quizzes that you have created or have access
to.

Procedure
Click Learn > Library.

The system displays the Library page.

Library field descriptions
Name Description
Format The format of the course or quiz.
Title The name of the course or quiz.
Topic The topic of the course or quiz.

Courses and quizzes can be grouped into topics when they are created.
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Name Description
Duration The duration of the course or quiz that is assigned.
Type The type of assignment. The options are:

• Course

• Quiz

• Course & Quiz

Assigning a course or a quiz
About this task
Use this procedure to assign a course or quiz to employees that you have access to.

Procedure
1. Click Learn > Library.

The system displays the Library page.

2. Select the courses or quizzes that you want to assign from the listing of directories.

3. Click Assign.

4. On the Assign Course/Quiz page, filter the employees you want to assign the course or quiz
to using theDepartment, Role, and Employeesdrop-down list.

5. For completion of the course or quiz, select a Due Date.

6. Click Assign.

The system displays the course or quiz in the inbox of the assigned employee, as well as on
the My Assignment screen of the employee.

Adding a quiz
Procedure

1. Click Learn > Library.

2. On the Library screen, click Add Quiz.

The system displays the Add Quiz page .

3. On the Definitions screen, enter the appropriate details.

4. Click Questions.
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5. On the Questions screen, click Add to do the following:

a. In the Questions text field, enter the question.

b. In the Options(s) text field, enter an answer. Click Add to add as many options as you
want to provide to the employee.

c. Select the option that denotes the correct answer.

d. Click Save & Add another to add as many questions to the quiz as you want.

6. Click Grading.

7. On the Grading screen, to enter a grade for the quiz as given in the page, click Add.

8. To view the summary of the quiz and to review the data for accuracy, click Preview.

9. Click one of the following:

• Save Quiz

• Save as Draft

Adding a quiz field descriptions
Definition

Name Description
Name The unique identifying name for the quiz. You can enter up to 500

characters in this field.

This field is mandatory.
Description A brief description of the function of the quiz. You can enter up to 1000

characters in this field.
Topic The topic of the quiz. You can enter up to 100 characters in this field.

This field is mandatory.
Duration (Mins) The time that the employee has to complete the quiz. This field cannot

exceed 4 digits.
Pass (%) The percentage that the employee needs to pass the quiz.

You can enter a value that is less than or equal to 100.

This field is mandatory.
Quiz Lockout duration
(Days)

The number of days that the quiz remains valid after it has been assigned.
If a quiz is used in multiple courses, an assigned user or employee does
not have to retake a quiz that they have already been assigned or
completed.

This field cannot exceed 4 characters.
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Name Description
Number of Questions to be
assigned

The value to assign a certain number of questions in the quiz on a random
basis. For example, you may have 30 questions in the quiz and want to
assign only 10 randomly.

This field cannot exceed 3 characters.

This field is mandatory.
Assigned Questions
Lockout (Weeks)

The value to maintain the history of quiz questions assigned for a certain
period (in weeks) so that the quiz is not reassigned within that particular
period. The questions assigned previously will not appear in the reassigned
quiz. It starts from the date of first assignment of quiz.

For example, consider a quiz with 30 questions, of which 10 questions are
assigned, and a tracking period of 3 weeks. If a user is assigned Quiz ABC
four times within the 3–week period, the first time the user will be assigned
10 questions. The second time the user will be assigned 10 questions from
the remaining 20 unassigned questions, and the third time the user will be
assigned the remaining 10 questions. On the fourth assignment, any 10
questions from the 30 questions will be assigned.

Any assignment after the expiration of the 3–week tracking period can
contain any group of 10 questions. If a value is not entered for the tracking
period, any 10 questions might appear in the assignment.

This field cannot exceed 3 characters.

Questions

Name Description
Question The unique question in the quiz. You can enter up to 1000 characters in

this field.

This field is mandatory.
Option(s) The response to the question in the quiz. You can enter up to 500

characters in this field.

This field is mandatory.

Grading

Name Description
Grade The unique identifying name for the grade. You can enter up to 100

characters in this field.

This field is mandatory.
Minimum value The lowest range of the score of the grade in the quiz. This field cannot

exceed 100 characters.

This field is mandatory.

Table continues…
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Name Description
Maximum value The highest range of the score of the grade in the quiz. This field cannot

exceed 100 characters.

The grade ranges must ensure 100% coverage.

For example, Grade A is 91.00 to 100, Grade B is 81.00 to 90.99, and
Grade C is 0 to 80.99.

This field is mandatory.

Adding a course
About this task
Use this procedure to add courses in the Learn module. Courses can either be links to external
URLs, file documents that are copied into the system, or system quizzes. After you add the course,
the system displays it in Library, where the course can be assigned to employees.

Procedure
1. Click Learn > Library.

2. On the Library screen, click Add Course.

3. On the Add Course page, enter the appropriate details and click one of the following:

• Save: To save the course.

• Save & Add Another: To add another course.

Adding a course field descriptions
Name Description
DP OU Type The partition of the organization unit for which the course is made

available.
Name The unique identifying name of the course. You can enter up to 500

characters in this field.

This field is mandatory.
Description A brief description of the function of the course. You can enter up to 1000

characters in this field.
Topic The topic of the course. You can enter up to 500 characters in this field.

This field is mandatory.

Table continues…
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Name Description
Type The type of file. The options are:

• File: To upload a file.

• URL: To enter the location or the source of the course.

This field is mandatory.
File The location or the source of the course. You can specify the complete

path or select the file from the desired location.

This field is mandatory.
Associated Quiz The quiz that you must assign to the course. You can assign multiple

quizzes that are available. However, associating a quiz with a course is not
mandatory.

Reassignment Lockout
(days)

The number of days for which the assigned course is restricted from being
reassigned.

The maximum limit is 4 digits.
OU(s) The name of the organization units who can access the course.
Skill / Competencies The skill or competency that you want the employee to develop.

Note:

Skills are created in the Parameters section.

Viewing team assignments
About this task
Use the Team Assignment screen to view the list of courses and quizzes assigned to employees
that the logged in user has access to.

The list displays all the courses and quizzes that are Completed, New, or Pending.

Procedure
Click Learn > Team Assignment.

The system displays the Team Assignment page.

Viewing team assignments field descriptions
Name Description
Format The format of the course or quiz.

Table continues…
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Name Description
Level The level of the course selected. If it is a quiz, there will not be any value.
Employee The name of the employee who is taking the assignment.
Reporting To The reporting manager of the employee to whom the course or quiz is

assigned.
Name The name of the course or quiz.
Topic The topic of the course or quiz.

Courses and quizzes can be grouped into topics when they are being
created.

Assigned By The name of the user who assigned the course or quiz.
Assigned Date The date and time on which the course or quiz was assigned.
Assigned From The source from where the course or quiz is assigned.

Courses and quizzes can be assigned from Coach, Learn, or Evaluate
modules.

Due Date The date by which the course or quiz must be completed.
Duration The duration of the course or quiz that is assigned.
Score The score of the employee.

Scores show only if the assignment has a quiz.
Type The type of assignment. The options are:

• Course

• Quiz

• Course & Quiz
Status The status of the course or quiz. The options are:

• New

• Pending

• Completed

Viewing courses assigned to you
About this task
Use the My Assignment screen to view the list of courses and quizzes that are assigned to the
logged in user. The list displays all the courses and quizzes that are Completed, New, or Pending.

After the logged in user has gone through the course, the user can click Done and then take a quiz
if there is one associated to it.

Procedure
Click Learn > My Assignment.

Managing learning

May 2016 Using Avaya Workforce Optimization Select 108
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


The system displays a list of courses or quizzes that are assigned to you.

Viewing My Assignment field descriptions
Name Description
Format The format of the course or quiz.
Title The name of the course or quiz.
Topic The topic of the course or quiz.

Courses and quizzes can be grouped into topics when they are created.
Assigned By The name of the user who assigned the course or quiz.
Assigned Date The date and time on which the course or quiz was assigned.
Assigned From The source from where the course or quiz is assigned.

Courses and quizzes can be assigned from Coach, Learn, or Evaluate.
Due Date The date by which the course or quiz must be completed.
Duration The duration of the course or quiz that is assigned.
Score The score of the employee.

Scores show only if the assignment is a quiz.
Type The type of assignment.

The options are:

• Course

• Quiz

• Course & Quiz
Status The status of the course or quiz.

The options are:

• New

• Pending

• Completed

Taking a course or a quiz
Procedure

1. Click Learn > My Assignment.

The system displays a list of courses or quizzes that are assigned to you.

Viewing My Assignment field descriptions
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2. Click the course or quiz.

The system plays the course or quiz directly in your web browser using Windows Media
Player.

Note:

For the course or quiz to play successfully, you must first install the Windows Media Player
plugin for your browsers.

3. View the course status on completion.

If a particular course is not yet completed, the quiz details associated to that course displays
in red.
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Chapter 7: Managing coaching

Coach
The Coach module provides an automated framework for building personalized agent training
programs using quality and performance data. Supervisors and Managers can provide guidance and
critical feedback to agents who require improvement in specific areas of performance. Support to
define a list of performance attributes and create coaching plans for specific groups or employees is
also available. The alerts and reports in Avaya Workforce Optimization Select ensure follow-up is
done on time.

To take advantage of the Coach module, you must:

1. Identify areas of focus that a coaching needs to address and create parameters accordingly
in Avaya Workforce Optimization Select . Parameters are of two types, Skills and Reasons
for coaching.

2. Create a coaching plan to define the number of coaching sessions agents or employees
need to complete within a specified period.

3. Create Coachings which are task-oriented action plans and assign them to agents to
improve on specific areas of their performance. Coachings are usually Instructor Led
Training (ILT) sessions that you can track in Avaya Workforce Optimization Select .
However, you can also link Coachings to e-Learning courses and quizzes.

As a result, Supervisors can generate relevant summary reports to view a snapshot of all the
accepted and completed coachings in the system.

Manage Coaching

Adding Skills
About this task
Use this procedure to create a list of skills or competencies. Skills are used for selection while
defining a coaching session.

Procedure
1. Click Coach > Parameters.

2. On the Skills page, click Add Skill.
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3. On the Add New Skills page, enter the appropriate details and click one of the following:

• Save & Add Another: To save the skill that you created and add another skill.

• Save & Close: To save the skill that you created.

The system displays the skills in the Skills page.

Adding Skills field descriptions
Name Description
Skill The unique name of the skill that you are creating.

You can enter up to 100 characters in this field.

This field is mandatory.
Description A brief description of the skill.

You can enter up to 500 characters in this field.
Active The option to select the skill as an active skill.

By default, Active is selected.

Adding Reasons for Coaching
About this task
Use this procedure to create a list of reasons for coaching. Reasons for coaching are used for
selection while defining a coaching session.

Procedure
1. Click Coach > Parameters.

2. Click Reasons for Coaching.

3. On the Reasons for Coaching screen, click Add Reason.

4. On the Add New Reason screen, enter the appropriate details and click one of the following:

• Save & Add Another: To save the reason that you created and add another reason.

• Save & Close: To save the reason that you created.

Adding Reasons for Coaching field descriptions
Name Description
Reason The unique name of the reason that you are creating.

Table continues…
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Name Description
You can enter up to 100 characters in this field.

This field is mandatory.
Description A brief description of the reason.

You can enter up to 500 characters in this field.
Active The option to flag the reason as active and make it available for selection

while creating coachings.

By default, Active is selected.

Coaching Plans

Viewing coaching plans
About this task
Use this procedure to view coaching plans that are used by Supervisors to assign employees or
groups of employees a certain number of coaching assignments within a specified period.

Users (Supervisors, Quality analysts etc.) can use the Coaching plans to plan the number of
coaching assignments that the employees need to take.

Procedure
Click Coach > Plans.

The system displays the list of coaching plans.

Viewing coaching plans field descriptions
Name Description
Coaching Plan The coaching plan that is assigned to the coaching assignment.
Target The number of coaching assignments that the assigned employees are

expected to complete.
Created By The name of the user who created the coaching assignment.
Created On The date in mm/dd/yyyy format on which the coaching assignment was

created.
Updated By The user who has updated the coaching assignment.
Updated On The date on which the coaching assignment was updated. The date is in

the mm:dd:yyyy format.

Coaching Plans
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Creating a coaching plan
About this task
Use this procedure to create coaching plans for employees that you have access to. Use Coaching
plans to assign employees or groups of employees a certain number of coaching assignments
within a specified period.

Procedure
1. Click Coach > Plans.

The system displays the list of coaching plans.

2. Click Create.

3. On the Definition page, enter the appropriate details.

4. Click Employee Section and enter the appropriate details .

5. To apply the filter that you defined to the list of employees to be assigned to the coaching
plan, click Apply Filter.

6. Assign the number of coaching assignments that the assigned employees are expected to
complete in the Target field. You must filter the employees based on the criteria available
and define the number of assignments to be taken by them as part of the plan.

7. To review the data for accuracy and a summary of the details of the coaching plan, click
Preview & Save.

8. Click Save.

9. The system saves the coaching plan to the Plans list.

Creating a coaching plan field descriptions
Definition

Name Description
Coaching Plan The coaching plan that is associated with the coaching. Depending on the

plan selected, coaching assignments will be created for the employees
who were targeted as part of plan.

You can enter up to 100 characters in this field.

This field is mandatory.
Plan Period (Days) The duration in which the user is planning to ramp up the employee. The

number of days during which the coaching assignments must be
completed by the employees.

Table continues…
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Name Description
If the targeted number of assignments are not met, alerts are sent to the
creator of the coaching plan and the reporting manager. Alerts are sent in
48 hours, 24 hours, and on the last day of the plan.

You can enter up to a 4 digits in this field.

This field is mandatory.
DP OU Type The employees belonging to the data partition OU type that the plan will be

applied.

This field is mandatory.
Description A brief description of the plan function.

You can enter up to 500 characters in this field.
Active The option to select the plan as an active plan.

By default, Active is selected.

This field is mandatory.

Employee Filter

Name Description
Field The option to select one of the filters for employees to add a coaching

assignment.

The options are:

• Department

• Employee

• Groups

• Organization Unit

• Role

• Site

• Reporting To

• Tenure (Weeks)
Operator The Operator relative to the field selected. The options are:

• Equals

• Not Equal To

• Contains

• Does not contain

• Starts with

The default value is Equals.
Table continues…
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Name Description
This field is mandatory if you select Field.

Value The numerical value or value ranges selected for the Field and Operator
selected.

This field cannot exceed 500 characters.

This field is mandatory if you select Field.

Employee List

Name Description
Target The number of coaching assignments that the assigned employees are

expected to complete.

The target is evenly distributed to all the employees listed. However, the
user can alter the target for each employee.

This field cannot exceed 2 digits.

This field is mandatory.
Number of Coaching
assignment

The number of coaching assignments that you want the employee to
complete.

You must type 0 in the Number of Coaching assignment field if an
employee need not take any assignments even if the employee is part of
the plan.

Employee The name of the employee to whom the coaching assignment is assigned.
Tenure (Weeks) The tenure in weeks of the employee in the organization.
Reporting to/Supervisor The reporting manager of the employee.

This field is mandatory.
Department The department that the employee belongs to.

Viewing coaching assignments
About this task
Use this procedure to view the Coaching screen that lists all coaching sessions set up for the
employees that the logged user has access to. The list displays all the coaching assignments that
are Completed, New, or Pending.

To filter coaching sessions, use the following options in the list:

• Views
• Sort
• Filter

You can create a new coaching assignment, edit or delete existing coaching sessions if you have
adequate privileges.

Managing coaching

May 2016 Using Avaya Workforce Optimization Select 116
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


Procedure
1. Click Coach > Coachings.

The system displays a list of coaching sessions.

2. To view the details of a coaching assignment, click the View ( ) icon in the desired row.

3. To delete a coaching assignment, click Delete.

Viewing coaching assignments field descriptions
Name Description
Coaching Purpose The reason for creating the coaching assignment.
Coaching Level The level of the coaching assignment. The options are: 1, 2, or 3.
Coaching Plan The coaching plan that is assigned to the coaching assignment.
Employee The name of the employee to whom the coaching assignment is assigned.
Delivery Date The expected completion date of the coaching assignment. The date is in

the mm:dd:yyyy format.
Completion Date The expected completion date of the coaching assignment. The date is in

the mm:dd:yyyy format. By default, the nearest completion date
assignment shows on top of the list.

Updated On The date on which the coaching assignment was updated. The date is in
the mm:dd:yyyy format.

By default, the most recent date shows on top.
Coach The name of the coach assigned to the employee for coaching.
Created By The name of the user who created the coaching assignment.
Follow up date The follow-up date after the coaching session was completed. The date is

in the mm:dd:yyyy format.
Status The status of the coaching assignment.

Creating coaching assignments
About this task
Use this procedure to create coaching assignments for employees that the logged in user has
access to.

You can select the employees and assign coaching. You can also associate parameters such as
metrics, skills or competencies, reasons for coaching, provide an action plan, and schedule the
coaching assignments. You can also assign quiz to a coaching. You can attach e-learning courses
and documents or even provide URLs to courses that are deadline driven.

Viewing coaching assignments field descriptions
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A notification is sent to the selected employees when you assign the coaching assignment. The
employees can view the coaching assigned on the My Assignment page.

Procedure
1. Click Coach > Coachings.

The system displays a list of coaching sessions.

2. Click Create.

3. Enter the appropriate details on the page.

4. Click Save.

5. The system saves the coaching assignment and displays on the Coaching screen.
Employees whom you have assigned this coaching assignment receive a notification in their
inbox that a new coaching assignment is available for them.

Creating coaching assignments field descriptions
Coaching

Name Description
DP OU Type The partition of the organizational unit that the employee belongs to.

This field is mandatory in a data partitioned environment.
Coaching Plan The coaching plan to assign to the coaching assignment.
Coaching Level The level of the coaching assignment. The options are:

• 1

• 2

• 3

A higher level coaching indicates that the selected employees need
rigorous coaching.

The default level is 1.

This field is mandatory.
Coaching Purpose The reason for creating the coaching assignment.

This field cannot exceed 500 characters.

This field is mandatory.
Coach The name of the coach assigned to the employee for coaching .
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Employee Filter

Name Description
Field The option to select one of the filters for employees to add a coaching

assignment.

The options are:

• Department

• Employee

• Groups

• Organization Unit

• Role

• Site

• Reporting To

• Tenure (Weeks)
Operator The Operator relative to the field selected. The options are:

• Equals

• Not Equal To

• Contains

• Does not contain

• Starts with

The default value is Equals.

This field is mandatory if you select Field.
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.

This field is mandatory if Field is selected.

Employee List

Name Description
Target The number of coaching assignments that the assigned employees are

expected to complete.

The target is evenly distributed among all the employees listed. However,
you can alter the target for each employee.

This field cannot exceed 2 digits.

This field is mandatory.

Table continues…
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Name Description
Number of Coaching
assignment

The number of coaching assignments that you want the employee to
complete.

You must enter 0 in the Number of Coaching assignment field if an
employee need not take any assignments even if the employee is part of
the plan.

Employee The name of the employee to whom the coaching assignment is assigned.
Tenure (Weeks) The tenure in weeks of the employee in the organization.
Reporting To/Supervisor The reporting manager of the employee.

This field is mandatory.
Department The department that the employee belongs to.

Parameters

Name Description
Reasons for Coaching The reasons for coaching parameters defined in the Parameter section of

the Coach module.
Skill / Competencies The skills or competencies parameters defined in the Parameter section of

the Coach module.

Action Plan

Name Description
Action Plan A brief description of the action that the employee is expected to perform.

For example, Take a quiz or Enroll in class.

This field cannot exceed 1000 characters.

This field is mandatory.
Expected Improvement The improvement you expect to see in the performance of the employee

after the coaching is complete. For example, decreased AHT.

This field cannot exceed 1000 characters.
Schedule The schedule of the coaching assignment. You can set the schedule for a

particular day and time and also define the duration of the coaching
session.

Completion Date The expected completion date of the coaching assignment.

The deadline must be met by the coach and employee.

This field is mandatory.
Duration (Mins) The duration of the coaching session.
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Follow-up

Name Description
On The date of follow-up.

You can select a date to follow up the coaching to monitor if the purpose of
coaching is met and also track the improvement.

__ days after the completion
of the Coaching

The number of days from the coaching session after which the follow-up
session must be performed.

The default value is 15.

Comments

Name Description
Enter comments The option to enter the comments regarding the coaching.

This field cannot exceed 1000 characters.

Viewing My Assignment
About this task
Use the My Assignment screen to view the list of coaching sessions that is assigned to you.

After you complete the assignment, you must go to the respective assignment on the My
Assignment page and click Complete. Only then the status of the assignment is updated to
Completed. You can also enter your comments before accepting the coaching session.

Procedure
Click Coach > My Assignment.

The system displays the list of coaching sessions that is assigned to you.

Viewing My Assignment field descriptions
Name Description
Coaching Purpose The reason for creating the coaching assignment.
Coaching Level The level of the coaching assignment. The options are: 1, 2, or 3.
Coaching Plan The coaching plan that is assigned to the coaching assignment.
Employee The name of the employee to whom the coaching assignment is assigned.

Table continues…
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Name Description
Delivery Date The expected completion date of the coaching assignment. The date is in

the mm:dd:yyyy format.
Completion Date The expected completion date of the coaching assignment. The date is in

the mm:dd:yyyy format. By default, the nearest completion date
assignment shows on top of the list.

Updated On The date on which the coaching assignment was updated. The date is in
the mm:dd:yyyy format.

Coach The name of the coach assigned to the employee for coaching.
Created By The name of the user who created the coaching assignment.
Follow up date The follow-up date after the coaching session was completed. The date is

in the mm:dd:yyyy format.
Status The status of the coaching assignment.
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Chapter 8: Managing reports

Reports
Contact centers need efficient and powerful tools to translate data to business intelligence.
Executives need to gain insight into how the organization as a whole is performing. Supervisors and
managers need statistics around individual or team performance. Use the Reports module in Avaya
Workforce Optimization Select to generate different types of report views that are essential to
business success.

The Reports module consists of the following features:

• Predefined set of report templates for each module.

• Report output in various formats such as PDF, Excel, HTML, and CSV.

• Reports scheduled to run automatically at the specified time.

• Reports shared with selected employees or groups, or all employees.

• Intuitive titles in the report output.

Default reports
The predefined set of report templates are:

• Interaction Details
• Interaction Summary
• Interaction Trend
• AHT Trend
• Evaluations Summary
• Evaluations Trend
• Evaluations Details
• EHT Trend
• Coaching Summary
• Course & Quiz Summary
• Web Usage Audit
• User Access
• Employee Voice Configuration
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Report templates
Interactions

Name Description
Interactions Details The report highlights details about all recorded interactions for a site,

organization unit, group, and employee depending on the filter criteria that
you select.

Supervisors can:

• Get a snapshot of the hold count and hold duration of all the interactions
of the employees that the supervisor has access to.

• View the report output grouped by Organization Units, Sites, Groups, and
Employees.

The report output displays the following details about the interaction:

• Start and end time of the interaction

• Name of the employee who attended the interaction

• Name of the employee who ended the interaction

• Name of the supervisor that the employee reports to

• Duration of the interaction in the hh:mm:ss format

• Number of holds and the hold duration of an interaction

• Called party, calling party, and call type of the interaction

• Interaction ID, queue, and queue type of the interaction
Interactions Summary The report highlights a summary of all recorded interactions for a site,

organization unit, group, and employee depending on the filter criteria that
you select.

Supervisors can:

• Get a snapshot of the AHT, hold count, transfers, screens, and the
number of interactions made by an employee.

• View the report output grouped by Organization Units, Sites, Groups, and
Employees.

The report output displays the following details about the interaction:

• Names of the employees who attended the interaction

• Number of interactions handled by each employee

• Duration of the interaction in the hh:mm:ss format

• Average handle time of the interaction in seconds

• Number of holds, transfers, and screens for an interaction

Table continues…
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Name Description
Interactions Trend The report displays the interactions recorded for employees in the contact

center over a specific period of time such as quarterly, monthly, weekly or
daily.

The report output displays the interaction count and duration for the
specified time period depending on the filter criteria that you select.

AHT Trend The report displays the average handle time between the employee and
customer based on organization unit, group, and employees, over a
specific period of time.

Supervisors or managers can choose to view the output in a graphical or
data format displaying the trend.

Evaluate

Name Description
Evaluations Summary The report highlights details about all evaluations for interactions for a site,

organization unit, group, and employee depending on the filter criteria that
you select.

Supervisors can:

• Get a snapshot view on total number of evaluations, average score of all
evaluations and percentage of evaluations for various Queues,
Organization Units, Groups and Employees.

• View the report output grouped by Organization Units, Sites, Groups, and
Employees.

The report output displays the following details about the evaluation:

• Total evaluations

• Total evaluations summary

• Average score

• Average score summary

• Average percentage

• Average percentage summary
Evaluations Trend The report trend view of how many evaluations are performed for specific

period and what are the average scores achieved, based on the options
you select.

Supervisors can:

• Get a snapshot of the number of evaluations, average score and the total
evaluations performed by an employee.

• View the report output grouped by Organization Units, Sites, Groups, and
Employees.

Table continues…
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Name Description
The report output displays the following details about the interaction:

• Number of evaluations

• Average score

• Total number of evaluations

• Total average score
EHT Trend The report displays the trend of the total number of evaluations and the

average evaluation handle grouped by Organization Units, Sites, Groups,
and Employees for the specified period of time. Supervisors or managers
can choose to view the output in a graphical or data format.

The report output displays the evaluation handle time and duration for the
specified period of time.

Evaluation Details The report highlights details about all evaluations for a site, organization
unit, group, and employee depending on the filter criteria that you select.

Supervisors can:

• Get a snapshot of evaluations on all the interactions of the employees
that you have access to.

• View the report output grouped by Organization Units, Sites, Groups, and
Employees.

The report output displays the following details about the interaction:

• Overall scores for evaluation

• Scores for primary performance criteria

• Scores for individual scoring criteria

• Overall average score of selected employees

Learn

Name Description
Course and Quiz Summary The report highlights details of the number of courses and quizzes

assigned to the employees depending on the filter criteria that you select. It
also displays the number quizzes an employee had taken, their status and
corresponding scores.

The report output displays the following details:

• Start and end time of the learning assignments

• Name of the employee who attended the learn sessions

• Purpose of assigning the learning sessions

• Evaluation plan based on which the agent was evaluated
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Coach

Name Description
Coaching Summary The report highlights details of the number of coaching sessions assigned

to the employees depending on the filter criteria that you select.

The report output displays the following details about the evaluation:

• Start and end time of the coaching sessions

• Name of the employee who attended the coaching sessions

• Purpose of assigning the coaching sessions

• Evaluation plan based on which the agent was evaluated

• Name of the employee assigned to coach the agents

Administration

Name Description
User Access The report displays the details of the users’ access and all the privileges

enabled for employees. The user who generates the report can view all the
privileges enabled for employees that the user has access to.

Employee Voice
Configuration

The report provides information of all the voice configuration options
enabled for employees. The user who generates the report can view all the
voice configuration options enabled for employees that the user has
access to.

Web Usage Audit The report displays the details of the web application access and user
activity.

Create a new report

Selecting a report template
Procedure

1. Click Reports > Reports > Templates.

2. To select the template category, click Interactions, Evaluations, Coach,Learn or
Administration.

The system displays the available templates in each category.

3. To create a report of contact center use and agent performance, select a template from
Interactions.

• Interactions Details

• Interactions Summary
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• Interactions Trend
• AHT Trend

4. To create a report on agent evaluations, select a template from Evaluations.

• Evaluation Details
• Evaluations Summary
• Evaluations Trend

5. To create a report on agent coaching, select a template from Coach.

• Coaching Summary

6. To create a report on agent learning and assessment, select a template from Learn.

• Course and Quiz Summary

7. To create an administrative report of user access and voice configuration settings, select a
template from Administration.

• Employee Voice Configuration
• User Access
• Web Usage Audit

Next steps
Set up criteria for a new report.

Setting up criteria for a new report
About this task
The system displays the report template with the Criteria tab selected.

The filter criteria on each report is predefined based on the nature of the report. Some common
parameters include the date range and export format options.

Procedure
1. In Criteria, enter the parameters for the report from the available report criteria.

The parameters define the columns available in the report output.

2. From the Export drop-down menu, select the output format:

• HTML
• PDF
• CSV
• Excel

Next steps
Save report settings.
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Report template - Interactions Details field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition of the organization unit that the user generating the report has

access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Group by The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF
Table continues…
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Name Description
• Excel

• CSV

This field is mandatory.

Report template - Interactions Summary field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom
DP OU Type The partition of the organization unit that the user generating the report has

access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Group by The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees
Table continues…
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Name Description
This field is mandatory.

Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Interactions Trend field descriptions
Name Description
Trend The trend of the report. The options are:

• Quarterly

• Monthly

• Weekly

• Daily

The trend period for interactions. The options are:

• Call Duration: Select the duration for which the trend must be
calculated.

• Base Date: Specify a date from when the interaction trend must be
calculated.

This field is mandatory.
DP OU Type The partition of the organization unit that the user generating the report has

access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employee The employee list available for selection, which is based on the

organization unit and group that the user selects.
Table continues…
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Name Description
This field is mandatory.

Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Display The format in which you want to display the report output. The options are:

• Chart

• Date

• Both

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - AHT Trend field descriptions
Name Description
Trend The time period for which you want to generate the trend report. The

options are:

• Quarterly

• Monthly

• Weekly

• Daily

This field is mandatory.
Trend Period The duration within the particular trend period for which you want to

analyze the trend.

• Call Duration: Select the duration for which the trend must be
calculated.

• Base Date: Specify a date from when the trend must be calculated.

Table continues…
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Name Description
DP OU Type The partition of the organization unit that the user generating the report has

access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Display The format in which you want to display the report output. The options are:

• Chart

• Date

• Both

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.
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Report template - Evaluations Summary field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition of the organization unit that the user generating the report has

access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Forms The evaluation forms available for selection, which is based on the

organization unit and group that the user selects.
Reviewers The supervisors or managers who have the privileges to evaluate an

employee.
Status The status of the assigned coaching. The options are:

• All

• Completed

• New
Table continues…

Managing reports

May 2016 Using Avaya Workforce Optimization Select 134
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


Name Description
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Evaluations Trend field descriptions
Name Description
Trend The trend of the report. The options are:

• Quarterly

• Monthly

• Weekly

• Daily

The trend period for evaluations. The options are:

• Call Duration: Select the call duration for last two, three, or four
quarters.

• Base Date: Specify a date from when the interaction trend must be
calculated.

DP OU Type The partition of the organization unit that the user generating the report has
access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
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Name Description
Forms The evaluation forms available for selection, which is based on the

organization unit and group that the user selects.
Reviewers The employees who have the privileges to evaluate an employee.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - EHT trend field descriptions
Name Description
Trend The time period for which you want to generate the trend report. The

options are:

• Quarterly

• Monthly

• Weekly

• Daily

This field is mandatory.
Trend Period The duration within the particular trend period for which you want to

analyze the trend.

• Call Duration: Select the duration for which the trend must be
calculated.

• Base Date: Specify a date from when the trend must be calculated.
DP OU Type The partition of the organization unit that the user generating the report has

access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

Table continues…
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Name Description
This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Forms The evaluation forms available for selection, which is based on the

organization unit and group that the user selects.
Reviewers The employees who have the privileges to evaluate an employee.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Evaluation Details field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month
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Name Description
• Custom

DP OU Type The partition of the organization unit that the user generating the report has
access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Forms The evaluation forms available for selection, which is based on the

organization unit and group that the user selects.
Reviewers The supervisors or managers who have the privileges to evaluate an

employee.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.
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Report template - Coaching Summary field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition of the organization unit that the user generating the report has

access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Forms The evaluation forms available for selection, which is based on the

organization unit and group that the user selects.
Reviewers The supervisors or managers who have the privileges to evaluate an

employee.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees
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Name Description
This field is mandatory.

Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Course and Quiz Summary field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition of the organization unit that the user generating the report has

access to.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that the user generating the report has access to.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.
Sites The available sites.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
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Name Description
Status The status of the course and quiz completion. The options are:

• All

• Completed
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - User Access field descriptions
Name Description
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Modules The modules in the application.

This field is mandatory.
Sub modules The sub modules for each module.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Employee Voice Configuration field descriptions
Name Description
Groups The groups that the user generating the report has access to.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.
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Name Description
Recordings The interaction recording options for employees. The options are:

• Yes: View the list of employees for whom the interaction recording option
is enabled

• No: View the list of employees for whom the interaction recording option
is disabled

Screen Capture The screen recording options for employees. The options are:

• Yes: View the list of employees for whom the screen recording option is
enabled

• No: View the list of employees for whom the screen recording option is
disabled

Recording Type The interaction recording rules.
Screen Capture Type The screen recording rules.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Web Usage Audit field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
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Name Description
Modules The modules in the application.
Sub modules The sub modules for each module.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Saving a report
About this task
You can modify an existing report template and save the template as a report with another name.
You can specify the required criteria that meets your business requirement and generate the report.
You can also share the report with other users.

Procedure
1. In the Save Settings tab, in Report Name, enter the name by which you want to save the

report.

2. (Optional) In Description, enter a description of the report.

Next steps
Share report.

Saving reports field descriptions
Name Description
Report Name The name of the report.
Description The description of the report.

Sharing a report
About this task
Use this procedure to share a saved report with other employees of the group.

You can share a report with user groups that you can access or with everyone available in the
system.

Create a new report

May 2016 Using Avaya Workforce Optimization Select 143
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


Procedure
1. From Share, select one of the following to share the report with other users.

• Me: To set the report as private and restrict other users to view the report.
• Selected Groups: To share the report with the groups that you have access to.

Employees belonging to the group can use the report.
• Everyone: To share the report with all available users.

2. To share the report with specific employees and groups, select Selected Groups.

The system displays the Group and Employee search and select options.

3. Select one or more groups from the Available Groups list.

a. To search a group, type the first few characters of the group name in Search.
b. To move a single selection from the list, use the Move Selected button.
c. To move multiple selections from lists, use the Move All button.

4. To remove groups from the Assigned Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

5. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in Search.
b. To move a single selection from the list, use the Move Selected button.
c. To move multiple selections from lists, use the Move All button.

6. To remove employees from the Assigned Employees list; select one or more employees and
use the Remove Selected and Remove All buttons.

Next steps
Schedule a report.

Scheduling a report
About this task
Use this procedure to schedule a report to run on a one-time basis, hourly, daily, weekly, or monthly.
You can email reports in PDF, Excel and CSV format to users in your organization.

Before you begin
Define the report criteria and save the report before scheduling.

Procedure
1. In Scheduler, select the options to schedule the report.

2. Select Enable Schedule.

3. Under Scheduler, select or enter the options to schedule the report on one-time, hourly,
daily, weekly, or monthly basis.
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4. Click Save and Close to save and close the report

5. Click Run to run the report.

Scheduling reports field description
Scheduler

Name Description
Once The option to generate the report once. For Once, you can specify the

following parameters:

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

Hour The option to generate the report on an hourly basis. For Hour recurrence,
you can specify the following parameters:

• Run the Schedule Every X Hours: Specify the hourly interval at which
the report must be generated periodically.

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

• End Schedule On: Specify the date when the generation of the
scheduled report must end.

Daily The option to generate the report at specified intervals each day. For
Daily recurrence, you can specify the following parameters:

• Every _ day(s): Specify the interval at which the report must be
generated periodically.

• Every Week day: Specify to run the scheduled report on all week days
excluding weekend.

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

• End Schedule On: Specify the date when the generation of the
scheduled report must end.

Weekly The option to generate the report on the specified day of the week.

• On Day: Specify the day of the week to run the scheduled report.

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

• End Schedule On: Specify the date when the generation of the
scheduled report must end.
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Name Description
Monthly The option to generate the report on the specified day of the month.

• Months: Specify the month to run the scheduled report.

• Enter Day(s): Specify the day(s) of the week to run the scheduled report.

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

• End Schedule On: Specify the date when the generation of the
scheduled report must end.

Email Option

Name Description
Name The name of the employee scheduling the report.
To The recipients of the report.
Subject The subject of the scheduled email.
Messages The message of the scheduled email.
Report Name The name of the scheduled report.
Output Type The output format in which the report is delivered.

View report results

Viewing reporting results
About this task
Use this procedure to view the results of the published reports indicated by type, report name,
module, report generation details, and report status.

You can view a report with the Completed status in any chosen format. You can also view the
different versions of a published report.

Procedure
1. Click Reports > Results.

2. From the list of published reports, click the Status link of the report.

The system displays the report in the specified format.

3. Click the Status link to view the details of a report.
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The system displays the report in one of the following formats selected at the time of
publishing the report:

• HTML

• PDF

• Excel

• CSV

4. Use the Pagination controls to navigate through the report list. You can choose the number
of records you want to view on each page.

Viewing reporting results field descriptions
Name Description
Report Name The name of the report.
Module The category of the report that is generated.
Last Run The date on which the report was last run.
xRun The number of times the report was generated.
Status The status of the report generation. The options are:

Icon Name Description
Schedule The report that runs at a scheduled interval.

Public The report that is shared with all users in the selected group.

Downloading a report
About this task
Supervisors or managers can download published reports.

Procedure
1. Click Reports > Results.

2. From the list of published reports, click the Status link of the report.

The system displays the report in the specified format.

3. Click the Download ( ) icon.

The system downloads the report on your machine.
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Printing a report
About this task
Supervisors or managers can print published reports.

Procedure
1. Click Reports > Results.

2. From the list of published reports, click the Status link of the report.

The system displays the report in the specified format.

3. Click Print to print a report.

4. To print reports that are in PDF output, click the Print (  icon.

The system sends the report to the printer connected to your machine.

Editing a report
About this task
Users can edit saved reports by modifying the criteria, settings information, and scheduler details.

Procedure
1. Click Reports > Reports > Saved Reports.

The system displays the list of saved reports.

2. Select the report that you want to modify and click the edit ( ) icon.

3. Modify the appropriate fields in the following tabs:

• Criteria : Lists the report trend options.

• Save Settings : Lists the report name, description, and report sharing options.

• Scheduler : Lists the frequency and email delivery options of a report.

4. In the Criteria or Save Settings tabs, click one of the following:

• Cancel : To discard the modification and close the report.

• Run : To generate the report.

• Save and Close.

5. In the Scheduler tab, click one of the following:

• Cancel : To discard the modification and close the report.

• Reset : To discard the scheduled details.
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• Schedule : To set the frequency and email delivery options of a report.

Editing a report
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Chapter 9: Managing notifications

Notifications
Using the Notifications feature in Avaya Workforce Optimization Select, users can receive real-time
alerts and notices for predefined contact center conditions, both mission-critical and informational.
Based on the Avaya Workforce Optimization Select modules purchased, users can subscribe to
alerts to manage and control contact center activities. Users can also specify if they want these
alerts and notices to appear in the notification inbox or sent through email. The notifications inform
the user about issues or situations that require immediate attention or notify the user on general
information about interactions.

The types of notifications are:

• Alerts: System-generated, real-time notifications that trigger when users cross the defined
threshold value. For example, you can configure alerts that inform you about the exceeded
number of holds, hold duration, and AHT by your team. The alerts that you can subscribe to
depend on the threshold values set by the administrator.

• Notices: Custom messages that can be sent to users that you have access to. Notices provide
more information including general information and feedback.

Supervisors can use notifications to:

• Assess and measure employee performance to improve customer satisfaction.
• Send custom notices to employees that supervisors have access to, apart from system-

generated alerts.
• Broadcast messages to users through email or have messages delivered to the notification

inbox. Supervisors can broadcast messages as an alert or a notice and also send a custom
message to members in the team.

• Send notifications during live monitoring of interactions to provide instant email feedback to the
employee.

Viewing notifications
About this task
Use this procedure to view notifications that you receive as alerts or notices in your notifications
inbox. When the user exceeds the threshold value of defined rule, the system triggers an alert
through email or directly to the notifications inbox. Users can also receive notices about general
feedback or information during live interactions.
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Procedure
1. Click Notifications.

2. On the View Notification page, click the appropriate option in the Show drop-down list to
display alerts, notices, or all messages.

3. Click the appropriate option in the Actions drop-down menu to specify an action for the
notifications you receive.

Viewing notifications field descriptions
General

Name Description
Date The date and time of the notification.

You can sort the notifications by date or use the search criteria to filter your
search results.

Count The number of times that the notification alert is triggered.
Message The message of the notification.

Icon Name Description
Type The type of notification. The options are:

• Alerts: System-generated messages for AHT, hold count, hold duration,
notifications from the Appeals, Coach, Learn, and Evaluatemodules.
There is no subscription for supervisor or agent to receive these
notifications.

• Notices: Custom messages that users can send to provide feedback or
any other general information that the receiver needs to know.

Actions

Name Description
Mark as Read To mark the selected notifications as read.
Mark as Unread To mark the selected notifications as unread.
Mark as Helpful To mark the selected notifications as helpful notifications.
Mark as Not-Helpful To mark the selected notifications as not helpful.
Delete To delete the selected notifications.

Viewing notifications field descriptions
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Show

Name Description
All To select all notifications.
Alerts To select only alerts.
Notices To select only notices.

Managing notifications
About this task
Use Manage Notifications to manage the type of notifications that you want to receive through email
or to your notifications inbox.

Procedure
1. Click Notifications > Manage Notifications.

2. In the Email column, click the appropriate option.

3. In the Inbox column, click the appropriate option.

4. Click Save.

Managing notifications field descriptions
Name Description
Message The message of the notification that is triggered when the threshold value

is exceeded.

Users can subscribe to the following alerts:

• My AHT exceeded by Queue (mins): When the user exceeds the AHT.

• Number of holds placed by me in Queue: When the user exceeds the
number of holds placed during the interaction.

• My hold duration by Queue (mins): When the user exceeds the hold
duration during the interaction.

Supervisors can subscribe to the following alerts:

• AHT exceeded by my team in Queue (mins): When members in the
supervisor’s team exceed the AHT.

• Number of holds by Queue for my team: When members in the
supervisor’s team exceed the number of holds placed during the
interaction.

Table continues…

Managing notifications
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Name Description
• Hold duration by Queue for my team (mins) for my team: When

members in the supervisor’s team exceed the hold duration during the
interaction.

Edit Messages The option to add a message to an existing notification message. The
content you add will appear as an extension to the existing message.

Email The option to select the notifications that you want to receive through
email.

Inbox The option to select the notifications that you want to receive directly to
your inbox.

Icon Name Description
Type The type of notification. The

options are:

• Alerts: System-generated
messages for AHT, hold count,
hold duration, notifications from
the Appeals, Coach, Learn,
and Evaluatemodules. There is
no subscription for supervisor or
agent to receive these
notifications.

• Notices: Custom messages that
users can send to provide
feedback or any other general
information that the receiver
needs to know.

Managing notifications field descriptions
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Chapter 10: Monitoring agent desktop

Desktop Analytics
Desktop Analytics is a client-server solution to capture, monitor and analyze agent desktops to
identify how well your agents perform their daily interactions, and access customer information from
native and web-based applications.

Desktop Analytics requires no additional programming or customization for monitoring user activity
on their desktop.

It operates in two distinct modes:

• Learning Mode installed on the server or the supervisor or manager’s desktop for monitoring
interactions of employees.

• Monitoring Mode running on agents’ desktop or employees attending to voice and non-voice
interactions in the contact center.

Benefits
• Enables PCI compliance and security during event monitoring.
• Monitors and reports on compliance, adherence, and other business requirements.
• Improves business processes, workflow, and rules.
• Identifies and measures training requirement of agents or employees.
• Enhances agent productivity by close monitoring and coaching.

Features
• Provides an easy-to-use, browser-based interface to configure the monitoring project.
• Configures automatic detection and masks confidential information such as credit card details.
• Captures and monitors actions, events, triggers, and navigation in real time.
• Integrates with third-party applications such as a Workforce Management tool.

Architecture
Desktop Analytics architecture consists of the following components:

• Learning Console
• Native resource files

May 2016 Using Avaya Workforce Optimization Select 154
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Workforce Optimization Select


• Web resource files
• Resource Generator
• Home Agent screen
• Unified Messaging
• Recorder
• Database

Learning mode
In the Learning mode, there is one instance of the Desktop Agent Service that runs on each
supervisor machine, and one instance of Desktop Agent Application that runs for each agent or
employee for every screen that they access.

For example, if there are more than one users that log on to the same machine, then multiple
Desktop Agent Application instances are created.

The sequence of execution in the Learning mode:

1. The supervisor configures the events and controls that need to be monitored and captured
using the Learning Console.

2. The Desktop Agent Service starts the Desktop Agent Application on the supervisor desktop.
3. On the agent desktop, the Desktop Agent Application injects the learning code into the

application that must be configured for monitoring.

Desktop Analytics supports monitoring of web-based applications and native windows.

The injected code monitors user activities and captures the data coming from add-ons or
DLLs and sends it to the Desktop Agent Application.

4. The Desktop Agent Application collects the incoming data and sends it to the Learning
Console.

5. The Learning Console processes the data, generates an XML file, and sends the file to
Resource Generator to generate project resource files.

6. The project resource files are sent to the Database through the Desktop Agent Server.

Monitoring mode
In the Monitoring mode, there is one instance of Desktop Agent Application for each agent or
employee to be monitored.

The sequence of execution in the Monitoring mode:

1. When the agent logs on to the desktop, the Desktop Agent Service sends a notification to
the Desktop Agent Server.

Learning mode
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2. The Desktop Agent Server copies all the project resource files and XML files to the Desktop
Agent Service and Desktop Agent Application locally.

3. The Desktop Agent Application processes these files and injects the code into the running
instances to capture the user activities. It sends back the captured data and triggers to the
Desktop Agent Application.

4. The Desktop Agent Application collects and processes the data and generates events such
as Pause, Resume, Call Data, Start and Stop.

5. The event triggers are sent to the Desktop Agent Server through a Desktop Agent Service.
6. The Desktop Agent Server saves these events in the database.
7. The program resource files and XML files have the list of URLs. When an agent opens a

document or application, the browser sends the URL information to the Desktop Agent
Application. The Desktop Agent Application verifies the URL in the program resource files
and XML files and injects the code into the browser.

8. Based on the triggers configured, you can capture:

• Application start and stop events.
• Contextual data such as application name, user ID, and machine name.
• Events with data and time.
• Changes to fields or data within the application.
• Navigation information such as Click, Mouse over and Mouse out.

Learning Console

Learning Console configuration
To successfully implement Desktop Agent, you must identify the applications that you must monitor
and track and then configure the Learning Console.

In the Learning mode, you can configure the Learning Console to capture:

• Web applications and native applications that a user visits.
• Screen images that a user browses or visits.
• Application-specific data such as specific button clicks or field changed events.
• Business data associated with interactions.

You can configure all user-level activity and export it to agent desktops that are to be monitored.

Use Projects as a placeholder to define the applications that you must monitor, track, and analyze.
Each Project is an abstract entity that contains a collection of automation rules configured for the
Desktop Agent. Depending on the business problem that you want to address or the business
process that you want to improve, you can create more than one project.

Monitoring agent desktop
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Learning Console configuration checklist
This checklist provides the steps for configuring the Learning Console in Learning mode.

No. Task Description Notes

1 Create a Project to
monitor applications on
agent desktop.

See Creating a Project on
page 157.

2 Add applications. See Adding an
Application on page 158.

3 Add a page or pages to
monitor.

See Adding a Document on
page 159.

4 Add a form from which
you want to capture data.

See Adding a Default
Form on page 160 and 
Adding a Custom Form on
page 160.

5 Add controls to track and
analyze user actions.

See Adding Controls on
page 161.

6 Add actions on which
you want to capture user
actions.

See Adding Actions on
page 162.

7 Add payloads to capture
data from agent desktop.

See Adding a Payload on
page 163

8 Save and export the
Learning project.

See Saving and exporting a
Project on page 164

9 Execute Database
scripts, and push
projects to agent
desktops to monitor.

For more information, see
Deploying Avaya
Workforce Optimization
Select.

Creating a project
About this task
Use this procedure to configure projects that define what applications you want to monitor on an
agent desktop.

Procedure
1. Start the Learning Console, and select one of the following:

• New Project
• Recent Projects

2. For a new project, enter a name and description.

Learning Console
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3. Click OK.

Example
For example, if you want to create a project that captures back office desktop processes for banking
transactions, create a project named Back Office.

Adding an application
Before you begin
Create a project.

About this task
Use this procedure to add applications that you want the Desktop Analytics Application to monitor
and capture.

You can add more than one application to a project.

Procedure
1. Right-click the project, and select Add Application.

2. Enter the required details.

3. On the Add Application page, drag and drop the spy (  ) icon on the control that you want
to monitor.

4. Click OK to save the application.

5. Click OK & Add Another to add another application.

Application field descriptions
Name Description
Alias The alias name of the application.
Name The name of the application.
Domain The domain name of the application.
Category The category of the application. The options are:

• Web: Applications that run within a browser.

• Native: Applications that are native such as CRM and ERP.
Type The type of application within a specific category.
User Actions The user actions within the application. The options are:

• Open

• Close
Table continues…

Monitoring agent desktop
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Name Description
For each user action, you can map Action triggers such as PAUSE,
RESUME, and CALLDATA. For example, you can configure the Desktop
Analytics Application to resume screen capture when the user opens the
browser to access a web-based application.

Adding a document
Before you begin
Add an application to a project

About this task
In a Learning project, the Learning Console will capture agent activities from the URL of the
application.

Use this procedure to create a document to capture the URL of the application. You can add
multiple documents to capture different pages within a single application.

Procedure
1. Open the web application you want to monitor on the agent machine.

2. Enter the appropriate information in the fields.

3. Click OK to save the document.

4. Click OK & Add Another to add another document.

5. Click OK & Add Form to add a form to the document.

Document field descriptions
Name Description
Alias The alias name for the document.
Name The name of the application.
Path/URL The path or URL of the application.
URL Match The options used to search and match the URL of the application that is

monitored. The options are:

• Exact

The Learning Console searches for the exact match of the URL as
specified in the Path/URL field. For example, if you set the Path/URL is
http://google.com and select this option, the Learning Console will
capture only the controls and triggers defined for this page.

• Partial Match
Table continues…

Learning Console
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Name Description
The Learning Console searches for keywords or strings to match in the
URL as specified in the Path/URL field.

Match Value The value to match when searching for Path/URL.

The default is the value captured by the Spy tool. You can change the
value from the default value to another value.

User Actions The user actions for the document. The options are:

• Open

• Close

• Unload

For each of the above user actions, you can map actions such as PAUSE,
RESUME, and CALLDATA. For example, you can configure the
application to pause when the page loads, and resume when the page
unloads.

Adding a default form
Before you begin
Add a document

About this task
A form defines what you want to monitor or capture within a document. Add controls to define the
user activity that needs to be captured within a document. You can add multiple controls within a
form.

Procedure
1. Right-click on the document and select Add Form.

2. Enter the name and alias name for the form.

3. To save the form, click OK.

4. To add another form, click OK & Add Another.

5. To add controls to the document, click OK & Add Controls.

Adding a custom form
Before you begin
Add a document

About this task
You can add forms under the default or custom categories.

Monitoring agent desktop
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A web page which has different sections within the page is captured as a custom form.

Procedure
1. Drag and drop the spy (  ) icon to add a control to a form.

The system displays a message to confirm whether you want to add a custom form.

2. Type the required details.

3. To save the form, click OK.

4. To add another form, click OK & Add Another.

5. To add controls to the document, click OK & Add Controls.

Custom form field descriptions
Name Description
Alias The alias name for the form.
Name The name of the form.
Form ID The class ID of the form.

This field is automatically populated when you capture the page using the
spy tool.

Form Class The name of the class.

This field is automatically populated when you capture the page using the
spy tool.

User Actions The user actions to be captured for the form. The options are:

• Load

• Unload

For each of the above user actions, you can map actions such as PAUSE,
RESUME, and CALLDATA.

Adding controls
Before you begin
Add form to a document.

About this task
Add controls within a form to capture a particular action such as a click or a text input in the
application or page. Controls can be Input Text Boxes, Radio Buttons, Check Boxes, and so on. You
can also add multiple controls to a form.

Learning Console
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Procedure
1. Right-click on the document, and select Add Form.

2. To add a control, drag the spy (  ) icon to the section in the page you want to capture.

The Learning Console automatically identifies the control properties.

3. On the web application page, drag and drop the spy tool on the control you want to monitor.

The Learning Console automatically identifies the properties of the control.

4. If you want to enable monitoring of sibling control types, select Enable Sibling.

5. Select the appropriate user action that you want to monitor, and click OK.

Controls field descriptions
Name Description
Alias The alias name for the control.
Name The name of the control.
Type The type of the control. This field is automatically populated when you drag

and drop the spy tool.

If you drop the spy tool on a button, the field is populated as Button.
ID The identifier that is unique to the type of the control. This field is

automatically populated.
Value The value, position, width, height of the control. This field is automatically

populated.
Class Name The class name of the control. This field is automatically populated.
Enable Sibling The option to enable monitoring of sibling control types. For example,

select the check box if you want to monitor when the agent clicks on any or
all of the buttons in a document.

User Actions The user actions for the control. The options are:

• Click

• Mouseover

• Mouseout

For each of the above user actions, you can map actions such as PAUSE,
RESUME, and CALLDATA.

Adding Actions
Before you begin
Add user actions

Monitoring agent desktop
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About this task
You can manually map Action to every user action.

Procedure
1. In User Action, select a user action on which you want to map anAction

2. Click the (+) icon on User Action.

3. On the Actions screen, select the Action to map.

You can add one or more than one Actions to the same user action.

Actions field descriptions
Name Description
PAUSE To capture critical information entered in the control that is mapped within

an application.

For example, to pause or mute voice recordings especially when the
customer is providing critical information like credit card details over the
phone.

RESUME To resume the capture of events within an application.

For example, you can use the action specifically after using the PAUSE
action.

CALLDATA To capture the text entered by a user in the application that is configured
for monitoring.

START SCREEN To start screen capture on the user desktop.
STOP SCREEN To stop screen capture on the user desktop.

Adding a Payload
Before you begin
Add Actions

About this task
When you map a user action with Actions such as Pause, RESUME or CALLDATA, you can add
Payload to define whether the text content to capture must be static or dynamic.

Procedure
1. In Actions, select a user action on which you want to map a Payload.

2. Click the (+) icon on User Action.

3. On the Actions screen, select the Payload.

You can add one or more than one Payload for the same user action.

Learning Console
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Payload field descriptions
Name Description
Static To capture a static text from the screen.

For example, when you map the text box where the user enters data in the
form, and enter the text box name as Var1, and value as ABC, the
Learning Console captures the value entered in Var1.

Dynamic To capture text dynamically from the screen.

For example, when you map the text box where the user enters data in the
form, the Learning Console dynamically captures the input by the user in
the text box.

Saving and exporting a project
About this task
You can save a copy of the project to create a backup, or export the project for sharing the project
with other users.

The supervisors with whom you share the project can the monitor configured agents.

Procedure
1. Click File > Save to save the project.

The system saves the project with a .kdmb extension.

2. Click File > Export to export the project.

The system saves the project with a .kdmb extension.

Monitor agent desktop
Once you configure the Learning Console and complete creating appropriate projects, you need to
push the project XML files onto agent machines.

Monitoring agent desktop
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Chapter 11: Customization

Updating profile
About this task
You can view your profile information such as name, reporting hierarchy, hire date, and other
details. You can change the time zone and language preferences.

Procedure
1. In the top-right corner of the Home page, click My Profile.

The system displays the basic profile information linked to your Avaya Workforce
Optimization Select account.

2. In Time Zone, select the time zone of your preference and click Set.

3. In Language, select the language of your preference and click Set.

Updating profile field descriptions
Name Description
Employee Code The code of the employee who is logged in.
First Name The name of the employee who is logged in.
User Name The user name of the employee who is logged in.
Hire Date The date when the employee joined the organization in the dd:mm:yy

format.
Department The name of the department that the employee belongs to.
Time Zone The default time zone setting.
Language The preferred default language setting.
Reporting To The name of the manager to whom the employee reports.
Group Belongs to The group that the employee belongs to.
Groups Access To The groups that the employee has access to.
Organization Units Access
To

The organization units that the employee has access to.
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Modifying password
About this task
Use this procedure to modify your password and set additional security on your account with secret
question settings.

Procedure
1. In the top-right corner of the Home page, click My Profile.

2. Click Settings.

3. In the Password section, type the old and new passwords.

4. Reenter the new password to confirm.

5. In the Secret Question section, select the question of your choice.

You can choose two secret questions. Ensure that the answers are private and easy to
remember.

6. Click Save.

Modifying password field descriptions
Password

Name Description
Current Password The current password used to log on to the application.
New Password The new password. The new password must adhere to the password

policy.
Confirm New Password The new password. Retype your new password to confirm.

Security Questions

Name Description
Secret Question 1 The first secret question.
Answer The answer to the selected first secret question.

The answer is not case sensitive.
Secret Question 2 The second secret question.
Answer The answer to the selected second secret question.

The answer is not case sensitive.

Customization
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Broadcasting messages
About this task
Use the Broadcast feature to send messages to multiple employees through email or as a
notification pop-up message. Supervisors or managers can send alerts to communicate critical
information or notices to provide value add information to employees.

Procedure
1. In the top-right corner of the Home page, click Broadcast.

The system displays the Broadcast window.

2. Select the recipients of the message.

You can send the message to multiple recipients at the same time.

3. Select the option to send the message through email or to the notification inbox of recipients.

4. In Message Type, select one of the following:

• Alert

• Notice

5. Enter the message to be broadcast.

6. Click Send.

Broadcasting messages field descriptions
Name Description
Broadcast To The recipients who receive the broadcast message.

You can send broadcast messages to multiple employees using the
following options:

• Site

• Organization Units

• Departments

• Groups

• Employees

For example, to select a specific employee in a Department, select the
Department from the drop-down list and the employee from the Employees
drop-down list.

Table continues…
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Name Description
Broadcast On The delivery mode of the broadcast message. The options are:

• Email: To send the message to users through an email.

• Notification Inbox: To send the message to users in their notification
inbox.

Note:

To broadcast messages through email:

• Ensure you configure the mail server.

• Ensure you use a valid email address of the recipients.
Message Type The type of the broadcast message. The options are:

• Alert: To alert users on critical information. For example, as a supervisor
you can send alert messages to the team about adhering to rules such
as greeting the customer or waiting for the customer to end the
interaction

• Notice: To communicate or convey general information. For example, as
a supervisor you can send a notice to the team about a new policy or
process in the department.

Message The content of the message you want to broadcast.

Customization
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Chapter 12: Resources

Documentation
See the following related documents at http://support.avaya.com.

Document
number

Title Use this document to: Audience

Overview
Avaya Workforce Optimization
Select Overview and
Specification

Provide a high-level functional
description of the capabilities of the
Workforce Optimization Select
application.

All

Implementing
Deploying Avaya Workforce
Optimization Select

Provide an end-to-end deployment
scenario including all products that
must function together, checklists,
and initial administration.

Deployment
engineers and
support personnel

Administering
Administering Avaya Workforce
Optimization Select

Explain how to use Workforce
Optimization Interface (WFO) to
configure your system, employees,
settings, and recording rules and
perform routine maintenance tasks.

The content is available in two
formats: HTML and PDF.

Administrators

Using
Using Avaya Workforce
Optimization Select

Explain how to use the Workforce
Optimization Interface (WFO) to
configure settings such as user
preferences, monitor and record
interactions, and access and
generate reports.

The content is available in two
formats: HTML and PDF.

Users

Table continues…
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Document
number

Title Use this document to: Audience

Avaya Workforce Optimization
Select Quick Reference Guide
for Supervisors

Understand the most common user
tasks that a Supervisor performs.

Users

Avaya Workforce Optimization
Select Quick Reference Guide
for Call Center Agents

Understand the most common user
tasks that an Agent performs.

Users

Avaya Workforce Optimization
Select Quick Reference Guide
for QA Analyst

Understand the most common user
tasks that a QA Analyst performs.

Users

Avaya Workforce Optimization
Select Quick Reference Guide
for Administrators

Understand the most common user
tasks that an Administrator performs.

Administrators

Finding documents on the Avaya Support website
About this task
Use this procedure to find product documentation on the Avaya Support website.

Procedure
1. Use a browser to navigate to the Avaya Support website at http://support.avaya.com/.

2. At the top of the screen, enter your username and password and click Login.

3. Put your cursor over Support by Product.

4. Click Documents.

5. In the Enter your Product Here search box, type the product name and then select the
product from the drop-down list.

6. If there is more than one release, select the appropriate release number from the Choose
Release drop-down list.

7. Use the Content Type filter on the left to select the type of document you are looking for, or
click Select All to see a list of all available documents.

For example, if you are looking for user guides, select User Guides in the Content Type
filter. Only documents in the selected category will appear in the list of documents.

8. Click Enter.

Resources
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Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot Avaya
products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos posted
on the website.

Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Viewing Avaya Mentor videos
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